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1. The DOCUMENTS SOAP Web Service

DOCUMENTS provides a Web service that allows third-party applications to
access DOCUMENTS files via a SOAP interface, and edit these.

Function scope
Currently, the following operations are available at different object levels:

User

Log on to/off the DOCUMENTS proxy.

- Logon a user under a different account.

- Determine the current user of the interface.
Read user properties

Folder

- Read user's Inbox folder.

- Read user's Sent folder.

- Determine folders and subfolders (for default folders).
- Read public folders.

File types

- Determine file type.
- Read file type information on:
- Fields, archives, document tabs, workflows

Files

- Create, edit and delete.

- Send files to new recipients (parallel for information, sequential).
- Add, read and delete documents.

- Read tasks.

- Read monitor.

- Archive DOCUMENTS files.

- Set resubmission date

- Read properties and auto texts

Search
- Perform searches in file types and archives.
Workflow

- Determine workflows.

- Start and close workflows for DOCUMENTS files.
- Read and run user actions for DOCUMENTS files.
- Start scripts on DOCUMENTS files.

Filing plans
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- Determine filing plans.
- Read filing plans in XML representation.

WSDL

- WSDL download.

Web service and proxy

The DOCUMENTS web service is not fully integrated in the DOCUMENTS server. It
is made available by a special proxy server ("DOCUMENTS-Proxy"). The
programmed application is a client of the proxy, which in turn operates as a client
of the DOCUMENTS server. The proxy transforms incoming SOAP-requests to
system-native function calls. The proxy also assists the server with the session-
management of SOAP clients. To enable the application to reach the proxy, you
may need to customize the address under which the communication takes place
(see below URL).

To be able to use this API, the following requirements must be met:

An installed DOCUMENTS server
A license file, which includes the DOCUMENTS-API license. With a differing
license the web service may be limited to a small set of functions, or it
may not operate at all.

3. Installing the DOCUMENTS proxy

As of ELC 3.60 or otris Portal 6.0, this comes as part of the DOCUMENTS
installation, residing in the scapproxy subdirectory.

The Soapproxy's installation directory also contains an actual service description
file (WSDL file). This is the significant WSDL for the proxy and for client
programming.

Calling the proxy by command line with the —h option results in a listing of further
possible command line parameters.

Specifications of the port and of the timeout period can be made here. Also a
(de-)installation as a Windows service is possible directly via the command line.
The connection parameters of the DOCUMENTS server can be determined by an
environment variable.
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[C:“\Programme*otrizportalbssoapproxyldocsoapproxy.exe —h
llsage: docsoapproxy [Kport> [timeout]]

Kport> iz the TCP port number of the proxy.
The internal default iz 118681.

Ktimeout> iz the timeout value of idle client
in seconds. The internal default is 3688.

To access a remote DOCUMEMIS server, set an environment
variable "DOCUMENTS_SERUVER'.
The internal default of this setting is "localhost:11888".

To install the proxy as a Windows sevrvice append "—i" to the
usuwal call. To uninstall the service enter “docsoapproxy —u'.

Fig. 1: Command line call docsoapproxy —h

docsoapproxy 10123 3000

Call via Port 10123 and timeout 3000

The proxy configuration can also be controlled with an ini-file which must reside
in the same directory as the proxy itself:

| Bldocsoapproxy.ni-Notepad =10l x|
File Edit Faormat Wiew Help

# configuration file for the DOCUMENT SOAP proxy -l
# SOAP proxy settings

ProxyPort=11001

ProxyTimeout=3600

# DOCUMENTS server settings
DocumentsPort=11000
DocumentsHost=127.0.0.1

< | vl 4

Fig. 2: docsoapproxy.ini as configuration file

The settings in the configuration file overwrite their counterparts in the command
line or in an environment variable.

- ProxyPort:
The port on which the proxy accepts the client requests. See also under: URL .

Default: 11001

- ProxyTimeout:
- The number of seconds after which a session expires, if it is not continued or
closed via logout.

Default: 300
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The sequence diagram from Fig. 3 shows the occurrence of a proxy timeout
after 3600s (see also Client timeout).

: SOAPProxy
SOAP-Client
(TO=36005) DOCUMENTS Server
I I I
1 1
Request L Invoke e.g. createFile2() I
Response P [success] fileld
- l 1
I
T 1 SOAPProxy- |
| Timeout :
36f0ﬂ => Forced logout |
I ——
1
1
Lo Invoke logout() 1
Logout-Response
(Session-Id = Q) < [success]

N |
| I
| 1 !

Fig. 3: Sequence diagram of a SOAP proxy timeout

- DocumentsPort:

The port on which the DOCUMENTS server accepts the proxy requests.
Default: 11000

- DocumentsHost:
The host name on which the DOCUMENTS server was started.

Default: localhost

- SequenceSessionId:
As of version ELC 3.60g/otirs Portal 6.0g, the constantly changing allocation
of Sessionlds can be suppressed by the setting SequenceSessionId=0 (see
WSDL tool and SOAP session).
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- PortalServerEncoding:
Version ELC 3.60g/otris Portal 6.0g allows defining for the proxy the
encoding containing the server data.
Unless defined otherwise, the system encoding is used, and it is displayed on
startup of the proxy, e.g.: English UnitedStates.1252.
For Windows, the encoding is built in this format:

[Language] [Country].[CodePage]

For more information on this, see Language Identifiers and Locales in
Microsoft® MSDN®.
When using an UTF-8 portal server, you need to set the following value

regardless of country and language:
PortalServerEncoding=UTF-8

Be aware that, when using an encoding different from the system encoding,
the SOAP client must consider this and customize its own encoding, if
necessary. This also applies to UTF-8 encoding. See Fig. 6 below.

- BlobBasePath:
Since WSDL DOCUMENTS-4.0.1870 it is possible to upload Blobs from the file
system directly. This option specifies a shared directory, which contains the
Blobs and which can be accessed by the SOAP proxy. The SOAP client does no
longer need to pass the blob content encoded in base64 format. It can pass a
file path instead, which is relative to the specified shared directory. From
there the SOAP proxy takes the file and uploads it to the DOCUMENTS server.

- SSL:
SSL=1 enables SSL or TLS encrypted communication between clients and the
SOAPProxy. This option is available since WSDL DOCUMENTS-4.0.1870.

- keyfile:
Path to a certificate/key file for the SSL encryption. The path can be either
absolute or relative to the installation path. The pem-file contains at least the
private RSA key and the certificate of SOAP proxy. Intermediate certificates of
a certificate chain may follow, if necessary.

- keypasswd:
Password to read the private key in the key file. The password has to be
specified in plain text.

As of version ELC 3.60g or otris Portal 6.0g, an additional version of the proxy
named docsoapproxy_log.exe is included in the setup, which logs SOAP
communication. This proxy makes debugging easier at communication level. See
also section WSDL tool and SOAP session.
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p From Service to Project

2.1 WSDL

The offered Web service is defined via the Web Service Definition Language
(WSDL), which as metalanguage in XML format specifies exchange protocols that
can be used to make server methods accessible from the outside.

<!-- operation request element -->
<element name="getFileTypes">
<complexType>
<sequence>

<element name="ignoreRight" type="xsd:boolean"
minOccurs="1" maxOccurs="1"/>

</sequence>

</complexType>
</element>
<!-- operation response element -->
<element name="getFileTypesResponse">
<complexType>

<sequence>

<element name="filetype"
type="DOCUMENTS:FileTypeShortDescr" minOccurs="0"
maxOccurs="unbounded" />

</sequence>
</complexType>

</element>

Excerpt from the WSDL for the "getFileTypes” method

The above WSDL excerpt describes how to initiate a request to the server. You

need to pass exactly one "ignoreRight" parameter to the "getFileTypes"
method, where the server sends an indeterminate number of
DOCUMENTS:FileTypeShortDescr objects as a response. However well-
defined and precise the WSDL may be, it does not allow direct programming, or

makes it very difficult.
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2.2 WSDL and programming language

The presence of a service description in WSDL format is therefore only the first
step in programming. To be able to use the deployed service, the matching
structures and classes for the respective programming language and IDE must be
generated from the WSDL. The current WSDL is deployed in the soapproxy
directory. It can also be loaded via http://soapproxy:11001/?2wsdl for an

active proxy (see WSDL) and via https://soapproxy:11001/?wsdl for SSL
support since WSDL DOCUMENTS-4.0.1870 respectively.

In Microsoft® Visual Studio 2005® this generation is performed by the
"wsdl.exe" program, which enables generation in the target programming
language via the /language option. Starting with Microsoft ® Visual Studio ®
2008 you find the file stored in the Windows SDK directory (%WindowsSdkDir%
eg. C: \ Program Files \ Microsoft SDKs \ Windows \ V6.0A \ bin).

"C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\Bin
\wsdl" /nologo /language:VB /out:.\DOCUMENTS.vb
/protocol:SOAP .\DOCUMENTS.wsdl

Call to generate the "DOCUMENTS.vb" in Visual Basic from the DOS shell in the
WSDL directory —genWrapper.cmd

The "DOCUMENTS.vb" now allows both generating interface objects and calling
object methods in Visual Basic using the classes derived from the WSDL.

Owing to the existing dependency, changes to the WSDL imply changes in the
generated code of the "DOCUMENTS . vb".

You need to be aware here that, depending on the programming language and
WSDL tool used, the generated code may turn out differently. Specific generation
tools are used to provide object accumulations in an array, while other tools
manage these in a separate list. Some tools are not aware of a distinguished
ReturnValue, while others automatically generate the first output parameter as
the return value of the function.

Of course, the offered data types are also dependent on the programming
language. What has been defined as "string" or "Integer" in the WSDL is
usually also offered in the destination language as "string" or "Integer". But
this may be entirely different with a "ByteArray" in Base64 encoding. In the case
of deviations in data types and signatures, the WSDL and the DOCUMENTS data
file generated from it should be compared with each other.
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Thus, for the above WSDL sample "getFileTypes", the following implementation
results for the generated DOCUMENTS . vb:

Public Function getFileTypes (..ByVal ignoreRight As Boolean)>
As FileTypeShortDescr ()

Dim results () As Object = Me.Invoke("getFileTypes",
New Object () {ignoreRight})

Return CType (results(0),FileTypeShortDescr())

End Function

Excerpt from the Documents.vb "getFileTypes" — Some attributes were omitted for
the sake of clarity.

Implementing this method is, however, not the only important issue here; calling
it from the program, which is really quite trivial, is equally important.

Dim doc as New DOCUMENTS

Dim ftsd() As FileTypeShortDescr
ftsd = doc.getFileTypes (False)
Calling the Documents.vb "getFileTypes" method in a program

As illustrated in the sample, the FileTypeShortDescr class is generated
including all its members defined in the WSDL.

For programming, therefore, this means convenient working on the basis of native
classes and methods. This eliminates the need for directly working at the SOAP
level below.

If the DOCUMENTS proxy is not running on the computer where the application is
developed, you must - after instantiating the DOCUMENTS object, specify the URL
on which the proxy accepts the requests of the programmed application.

The default setting from the WSDL "http://localhost:11001" applies when
proxy and application are running on the same local computer.

The URL is composed of the computer name under which it can be reached on the
net or its IP address, and the port.

Dim doc as New DOCUMENTS

Set 'proxy address

doc.Url ="http://proxyComputerOrIpAddress:11001"

URL under which the DOCUMENTS proxy can be reached by the application.
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2.3 WSDL tool and SOAP session

Communication between client and proxy is performed via the SOAP protocol. In
doing so, a unique SessionId that is threaded in the SOAP header ensuring that
the proxy returns the responses to the correct client is set for each individual
connection.

The communication process appears as follows:

Client A --> SessionId 0 --> Proxy

Client A logs in to the proxy using login

Proxy -->SessionId 8186860391163 --> Client A

and is returned a SessionlId in the SOAP header by the proxy

Client A -->SessionId 8186860391163 -->Proxy

Client A sends another request to the proxy, including the
previously contained SessionId in the SOAP header.

Proxy -->SessionId 8186860397652 -->Client A

Proxy identifies the request to be from client A; it
responds to it, also sending a new (!) SessionId.

Session handling via SOAP

For each new request of a client, the SessionId previously contained in the
response must also be sent. Only this string of SessionIds indicates and
identifies exactly one (1) session between client, proxy, and the DOCUMENTS
server. In doing so, the proxy can return a new SessionId on responding to the
request. But it does not necessarily have to change!

This mechanism is primarily used to prevent session hijacking, where a user draws
the session of an already authenticated user. Below login is performed and the
Userinfo function is started multiple times in succession before 1ogout occurs:

SOAP Interface Documentation 12



ionId: 818686M3911635
ion: B — 818686A3711635
Schreiber. Willi
urrent Session: 1 — 8186860397652
Userinfo Mame: Schreiber, Willi
Current Session: 2 — B186868397885
Userinfo Hame: Schreiber, Willi
Current Session: 3 — B1B86B6H397885
rinfo Mame: Schreiber, Willi
vent Sesszion: 4 — 8186860397854
o : Schreiber,. Willi
: 5 — 8186868397987
Schreiber,. Willi
: 6 — B18686B397959%
Schreiber, Willi
Current Session: 7 — B186868398888
Userinfo Mame: Schreiber,. Willi
Current Sesszion: 8 — 818686MA3798606A
Schreiber. Willi
: 9 — 8186860398112
Schreiber,. Willi
s on: 18 — 8186868398161
Userinfo Hame: Schreiber, Willi
END — Session

Fig. 4: Changing the Sessionlds as part of login/logout

Depending on the WSDL tool used, the SessionId must be explicitly added to
the SOAP header during implementation. This restriction does not apply to
Microsoft® Visual Studio® projects: here the SessionId is automatically set in
the background.

Allocating changing SessionIds can be prevented in the proxy's ini file
through the SequenceSessionId=0 directive (see SequenceSessionId).

2.4 Documents WSDL Version

The version number of the WSDL used in the Documents resides in the
targetNamespace of the WSDL:

<?xml version="1.0" encoding="UTF-8"?>
<definitions name="DOCUMENTS"

targetNamespace="http://xml.otris.de/ws/DOCUMENTS-
4.0.1870.wsdl"

Version of the WSDL used: DOCUMENTS-4.0.1870.wsd|

2.5 Working in a Microsoft® Visual Studio 2005® project
The following applies to setting up a Microsoft® Visual Studio 2005® project:
1. The Microsoft 3.0 Web service enhancements must be installed:

- Web Service Enhancements (WSE) 3.0 for Microsoft .NET
2. You need to add the following project references:

- System.Web.Services
- System.Xml

3. You should also add the WSDL file to the project:
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- Project File Explorer -> Context menu -> Add -> Existing Element ->
Select WSDL file

4. The classes from the WSDL must be:

- generated in the target programming language, e.g.
DOCUMENTS . vb see above
- and added to the project:

- Project File Explorer -> Context menu -> Add -> Existing Element -
> Select file

2.6 Sample code console application VB

Below we assume that in Microsoft® Visual Studio 2005® Visual Basic a project
named "docsample" was created for a console application and that the above
references were added to the project.

Add a class named "sample" to the project:
Public Class Sample
End Class
Moreover, add a "Shared Sub Main" method to the "Sample" class:
Public Class Sample
Public Shared Sub Main ()
End Sub

End Class

In the project properties the "Sample" class should now be proposed. In this
startup object, the "Main" method is automatically started for application startup.

Startseite CObjektbrowser .~ docsoapsample] DOCUMENTS.vb [ Sample.vb T DOCUMENTS. wadl
Anwendung
Assemblyname: Stammnamespace:
Kompilieren docsoapsample docsoapsample
Debuggen Anwendungstyp: Symbaol:
Konsolenanwendung " (Standardsymbal)
Verweise
Startobjekt:
Ressourcen v | [ assemblyinformationen...

Fig. 5: Selecting the startup object for the project

In the Main method you create a DOCUMENTS object and specify the URL under
which the proxy accepts your requests. Following this, login is performed, and the
number of file types visible to the user is determined. Finally, logout of the proxy
is performed.

Public Shared Sub Main ()
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' Instantiating the interface
Dim doc as New DOCUMENTS

' The URL under which the proxy can be reached by this
application.

doc.Url = "http://localhost:11001"
Try
' Login to proxy

' You may not be logged on to the server via the same
user

doc.login ("schreiber", "peachit","willi","","de")

' Which file types are available for this user on the

server?
Dim ftsd() As FileTypeShortDescr
ftsd = doc.getFileTypes (False)
If Not ftsd Is Nothing Then

Console.WriteLine ("Number of files: {0}Y,
ftsd.length)

End If
Catch ex AS Exception
Console.WritelLine ("Exception: {0}", ex.Message)
Finally
'Logout
doc.logout
End Try
End Sub
You may need to customize the codepage for the displaying console prior to
starting the "docsoapsample.exe" file; this particularly applies when the server

supports UTF-8 and the proxy was started in its ini file using the
"PortalServerEncoding=UTF-8" option.

PortalServerEncoding=UTF-8

Encoding setting in the docsoapproxy.ini

The "chcp" command, followed by a single Code Page Identifier (MSDN), then
allows toggling the console's codepage. The result for UTF-8 is the codepage
number 65001.
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== C:\WINDOWS\systen%32\cmd.exe

C:x\>chcp 65881
Aktive Codepage: 656801.

G2

Fig. 6: Setting the Unicode utf-8 codepage to 65001

In order for the text (e.g. umlauts) in the current codepage to be correctly
displayed on the current codepage, you must customize the console font, as
necessary. This can be carried out via the "Title bar of window -> Context menu ->
Properties".

=% Administrator: C:\Windows'\system32\cmd.exe

lows [Version 6.1.7681)
2007 Hicrosoft Corporation. All rights reserved.

Oppons  Fort | Lapour | Colers |

X Cose
Ede
Def auits

Properties

Window Preview Sie

Font ™ Bold fonks
T Congsolas

Il actes Fopd:

|

Selectad Fort - Lucida Console

Each character is
T screen powls wide
12 screen possls hagh

I (19 I Cancel

Fig. 7: Setting the console font Lucida Console

2.7 Creating a gSOAP Client with Visual C++ 2008°

The gSOAP toolkit provides an automated SOAP and XML data binding for C/C++.
It simplifies the development of SOAP Web Services and clients. To create a
gSOAP client the following tools are needed, which are included in the
gsoap\bin\win32 directory by the gSOAP available from SourceForge:

e The WSDL importer wsd12h.
e The stub compiler soapcpp2.
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The gSOAP importer wsdl12h imports the WSDL of a Web Service and generates a
header file that contains the C/C++ declarations of the service components. This
Header file will then be processed by the gSOAP compiler soapcpp2 to generate
the stubs for the client. Now we can begin to create a gSOAP client interacts with
the web service.

Download gSOAP from SourceForge.
Importing the WSDL by running wsd12h from the command line:

wsdl2h -I C:\gsoap-2.8\gsoap\WS -f -o doc4.h
“C:\Program Files\Documents4\soapproxy\DOCUMENTS.wsdl”

Option -1 tells the importer where to find the required gSOAP include
files. To generate C++ code, use option —f£. Option —o specifies the
output file. The last parameter specifies the SOAP API WSDL file to be
imported. In case of successful importing the output file doc4.h will be
produced.

3. Generating C++ stubs by running soapcpp2 from the command line:

soapcpp2 -C -L -I C:\gsoap-2.8\gsocap\import -w -x
doc4.h

Option —C indicates client-side code only. —L is needed if you do not want
to generate soapClientLib.cpp. Option —I specifies the include file
path. —w tells the generator not to produce schema files. —x tells it not to
produce XML message files.
4. Creating a console application with Visual C++ 2008°®
For the sake of simplicity, we create a C++ Win32 Console Application
project and accept thereby all of the default settings. The further steps
are described below.
1) Add the following files generated by gSOAP to the project under
Project > Add Existing Item:
e DOCUMENTS.nsmap
e soapC.cpp
e soapClient.cpp
e s50apDOCUMENTSProxy.h
e soapH.h
e soapStub.h
2) Add the following files from the gSOAP directory (C:\gsoap-
2.8\gsoap) to the project in the same way above:
e stdsoap2.cpp
e stdsoap2.h
3) Disable the use of precompiled headers for the following files:
e soapC.cpp
e soapClient.cpp
e Stdsoap2.cpp
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From the context menu of the files in the Solution Explorer
select Properties > C/C++ > Precompiled Headers,
change the option for Create/Use Precompiled Header
toNot Using Precompiled Headers.

4) Add include path to gSOAP (C:\gsoap-2.8\gsoap) under
Project > Properties > C/C++ > General >
Additional Include Directories.
5) Open the console application C++ file. Add the following
#includes to the top of the file just after the stdafx.h include:
e f#include “soapDOCUMENTsProxy.h”
e finclude “DOCUMENTS.nsmap”
e #include “stdsoap2.h”
5. Example code for the gSOAP client
#include "stdafx.h"
#include "soapDOCUMENTSProxy.h"
#include "DOCUMENTS.nsmap"
#include "stdsoap2.h"
#include <iostream>

#include <fstream>

using namespace std;

int tmain(int argc, TCHAR* argvl([])
{
// Create a gSOAP client object.
DOCUMENTS doc;
// Endpoint URL of soapproxy (change as needed)

doc.endpoint = "http://localhost:11001";

// Sample for login

~ns2_login reqg;

reqg.locale = "de";
reg.user = "schreiber";
req.principal = "peachit";
req.code = "";

reg.passwd = "willi";

~ns2 loginResponse res;

int ret = doc. nsl login(&req, é&res);
if (ret == SOAP OK)
cout << "\nLogin succeeded: " << res.session << endl;
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else
cerr << "Login failed with the error message: \n"

<< doc.soap->fault->faultstring;

// Sample for getInbox
_ns2 getlInbox reqg2;
_ns2 getInboxResponse res2;
ret = doc. nsl getlInbox(&reqg2, &res2);
if (ret == SOAP OK)
{
cout << "\nGetInbox succeeded: " << res2.idFolder << endl;
ns2 FileStatusList* fileStatuses = res2.fileStatuses;
unsigned int size = fileStatuses->fileStatus.size();
if (fileStatuses && size > 0)
{
// Sample for getFileInfo: We iterate through
// all files in the inbox.
~ns2 getFileInfo reg3;
~ns2 getFileInfoResponse res3;
reg3.allFields = true;
reg3.allAttributes = true;
for (unsigned int i = 0; 1 < size; ++1)
{
reqgq3.fileld = fileStatuses->fileStatus[i]->fileId;
ret = doc. nsl getFileInfo(&reg3, &res3);
if (ret == SOAP OK)

{

cout << "\n \n";

cout << "Information for file with id '"

<< reg3.fileId << "':\n";
cout << "filetype id: " << res3.filetypeld << endl;
cout << "filetype name: " << res3.filetypeName << endl;
cout << "filetype label: " << res3.filetypelabel << endl;

if (res3.fieldvalues)

{
cout << "\nField wvalues: \n";
vector<ns2_ FieldData* >* pFieldData =

& (res3.fieldvalues->field);
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vector<ns2 FieldData* >::iterator it;

for (it = pFieldData->begin(); it != pFieldData->end();
++1it)
{
cout << (*it)->name << ": " << (*it)->value << endl;

if (res3.documents)

{
cout << "\nDoc infos: \n";
vector<ns2 DocInfo* >* pDocInfo =

& (res3.documents->document) ;

vector<ns2 DocInfo* >::iterator it;

for (it = pDocInfo->begin(); it != pDocInfo->end(); ++it)
{
cout << "Id: " << (*it)->id << ", Name: " << (*it)->name
<< ", Size: " << (*it)->size << endl;

// Sample for getDocument

~ns2 getDocument reqg4;
~ns2 getDocumentResponse res4;

regd.fileld = reqg3.fileld;

reg4.docId = (*it)->id;
ret = doc. nsl getDocument (&req4d, &resd);
if (ret == SOAP_OK)
{
string fileName = "Sample " + res4.name;

ofstream outfile(fileName.c str(), ofstream::binary);

// Write the document content to file named 'fileName'

// in the current workspace
outfile.write((const char*)res4.data-> ptr, resd.size);

outfile.close();

else
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cerr << "GetDocument failed with the error message:

<< doc.soap->fault->faultstring;

else

cerr << "GetFileInfo failed with the error message:

<< doc.soap->fault->faultstring;

else

cerr << "GetInbox failed with the error message: \n"

<< doc.soap->fault->faultstring;

// Sample for logout
~ns2 logout reg5;
~ns2 logoutResponse resb5;
ret = doc. nsl logout(&reg5, &resd);
if (ret != SOAP OK)
cerr << "Logout failed with the error message: \n"
<< doc.socap->fault->faultstring;

return 0;

2.8 Creating a WCF Client with Visual C# 2008°

Windows Communication Foundation (WCF) is a tool in the .NET Framework
(since the version 3.0) for building service-oriented applications. A WCF client
communicates with a WCF service via an endpoint of the service, which consists

of the following properties:

e An Address that is a URL and indicates where the endpoint can be

accessed.
e A binding that specifies how the data will be transferred.
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A contract that defines the operations available.
A set of behaviors to customize the local behavior of the service endpoint.

How to create a WCF client with Visual C# 2008® using .NET Framework 3.5 will be
described step by step below.

1.

7.
using
using
using
using
using

using

Create a new C# console application project named docsoapcs.
Openthe Add Service Reference dialogunder Project > Add
Service Reference.

In the dialog enter the SOAP API WSDL file (such as C:\Program
Files\Documents4\soapproxy\DOCUMENTS.wsdl) into the entry
field Address and specify a namespace (being default
ServiceReferencel) for the generated code and click Ok.

Expand Service References in the Solution Explorer and double click
the namespace specified above (ServiceReferencel). In the Object
Browser you can see the generated client proxy class
DOCUMENTSPortTypeClient under the namespace
docsoapcs.ServiceReferencel.

Go to the console application C# file (Program.cs) and add the using
directive using docsoapcs.ServiceReferencel to the file.

Now you can create an instance of the WCF client and then call its
methods to invoke the service.

Example code for the WCF client

System;
System.Collections.Generic;
System.Ling;

System.Text;

System.IO;

docsoapcs.ServiceReferencel;

namespace docsoapcs

{

class Program

{

static void Main (string[] args)

{

// Create a WCF client object with the given client

// endpoint configuration to invoke the service.

// Make sure that the URL of the soapproxy is correct.
// The default is localhost. If the proxy is running
// on a different machine you have to correct this.

DOCUMENTSPortTypeClient myDoc = new
DOCUMENTSPortTypeClient ("DOCUMENTS", "http://localhost:11001");

string currOperation = null;
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string sessionId = null;
try
{
// Sample for login
currOperation = "Login";

myDoc.login ("schreiber", "peachit"™, "willi", "", "de",
out sessionId);

Console.WriteLine ("\nLogin succeeded: " + sessionId);

//Sample for getInbox
currOperation = "GetInbox";

FileStatus[] fileStatuses;

string idFolder = myDoc.getInbox (ref sessionId,
out fileStatuses);

Console.WriteLine ("\nGetInbox succeeded: " + idFolder);

// Sample for getFileInfo: We iterate through
// all files in the inbox

currOperation = "GetFileInfo";

foreach (FileStatus fileStatus in fileStatuses)
{

DocInfo[] documents;

string filetypeld;

string filetypeName;

string filetypeLabel;

FieldData[] fieldvalues = myDoc.getFileInfo(ref sessionId,
fileStatus.fileId, true, true, null, out documents,
out filetypeld, out filetypeName, out filetypelabel);

Console.WriteLine ("\n

\n");
Console.WriteLine ("Information for file with id '"
+ fileStatus.fileId + "':\n");
Console.WriteLine ("filetype id: " + filetypeId + "\n");
Console.WriteLine ("filetype name: " + filetypeName + "\n");
Console.Writeline ("filetype label: " + filetypeLabel
+ "\n");

Console.WriteLine ("\nField values: \n");
foreach (FieldData fieldData in fieldvalues)

{
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n. n

Console.WritelLine (fieldData.name +
+ fieldData.value + "\n");

Console.WriteLine ("\nDoc infos: \n");
foreach (DocInfo docInfo in documents)

{

Console.WriteLine ("Id: " 4+ docInfo.id + ", Name: " +
docInfo.name + ", Size: " + docInfo.size + "\n");

// Sample for getDocument
currOperation = "GetDocument";
int size;

string mime;

byte[] data;

string name = myDoc.getDocument (ref sessionId,
fileStatus.fileId, docInfo.id,
out size, out mime, out data);

// Write the document content to file
// named 'fileName' in the current workspace.

string fileName = "Sample " + name;

FileStream outfile = new FileStream(fileName,
FileMode.Create) ;

outfile.Write(data, 0, data.Length);

outfile.Close ()

}

catch (System.SystemException e)

{

Console.WriteLine ("\n" + currOperation + " failed with
the error message:\n" + e.Message);

}

finally

{

// Sample for logout
if (sessionId != null)

myDoc.logout (ref sessionId);

// Close the client

myDoc.Close () ;
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3.1 DOCUMENTS methods

Documents.archiveFiles

Description Archive DOCUMENTS files.

Input parameter filelds: 0..n string
List of technical names of the DOCUMENTS files to be
archived.

deleteOnSuccess: 1 Boolean optional
Specifies whether successfully archived DOCUMENTS files
should be deleted from DOCUMENTS afterwards. If this
parameter is missing, this will be interpreted as false.

Output parameter statusList: 0..n ArchiveStatus
Contains messages on history for each archive operation.

Sample VB
P ' Array with status information about the files which

"are currently in the users inbox
Dim fileStatuses() As FileStatus = Nothing

Dim idFolder As New String(String.Empty)
' get the inbox files
idFolder = doc.getinbox(fileStatuses)

' Now pick the first file
If fileStatuses.Length > 0 Then

Dim archiveStatus() As ArchiveStatus = Nothing
Dim deleteOnSuccess As Boolean = False

Dim filelds() As String = {fileStatuses(0).fileld}
' archive
archiveStatus = doc.archiveFiles(filelds, deleteOnSuccess)

" and check for the status information
For Each ars As ArchiveStatus In archiveStatus
Console.WriteLine("fileld: {0}", ars.fileld)
Console.WriteLine("messages: {0}", ars.messages)
Next
Else
Console.WriteLine("No file to archive")
End If

Explanation We get the first DOCUMENTS file from the Inbox, and then
determine its ID. This DOCUMENTS file is then transferred to the
archive assigned to it via its file type. The returning ArchiveStatus
object whose messages are written to the console will inform about
successful archive transfer.

Comment The ArchiveStatus lists error messages for transfer.
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Documents.bowserFolder

Description

List DOCUMENTS files of a folder.

Input parameter

folderName: 0..1string, optional
Name of a public folder.

folderld:0..1string, optional
The technical identifier of a folder can alternately be
specified for folderName or folderType.

folderType: 0..1String, optional
The type label of a personal default folder can alternately
be specified for folderName or folderld. A list of allowed
labels can be found in the Appendix Label for personal
default folders.

startindex: 1 Integer
Index of first file to be output. Counting starts with
number 0. When startindex=0 and count = -2, all
DOCUMENTS files of the folder will be listed at once. This
may take quite a long time, though.

count: 0..1 Integer, optional
The desired maximum number of files to be listed must
always be specified along with startindex. If the value is set
to -1, the function will use the number of files preset by
the user. If the value is set to -2, all files as of the
startindex will be listed.

preview: 0..1 Boolean
Specifies whether field contents should be output for
preview.

Output parameter

fieldNames: 1 StringList
List of field names for preview. The same labels as
described in the Appendix are used as field names for file
beschrieben (see field labels in 5.2). The parameter will
become obsolete if no preview is requested. This
parameter is a simple output parameter; you cannot pass a
list of field names here.

files: 0..n FolderFile
File list of folder or its currently requested section.

previousindex: 1 Integer
If going backwards in the list is allowed, then the starting
index for the first DOCUMENTS file of the previous page
will be output here along with a negative value.

nextindex: 1 Integer
If going forward in the list is allowed, then the starting
index for the first DOCUMENTS file of the next page will be
output here along with a negative value.

Return value

headline: 1 string
The heading for the folder.

Sample VB

Dim folderType As New String("Favourites")
"we don't need name and id

Dim folderName As New String(String.Empty)
Dim folderld As New String(String.Empty)

Dim files() As FolderFile = Nothing
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Dim headline As String

Dim startindex As Integer = 0
Dim previousindex As Integer
Dim nextindex As Integer

Dim count As Nullable(Of Integer)

Dim countSpecified As Boolean = count.HasValue
Dim preview As Boolean = False

Dim fieldNames As New List(Of String)

" browse

headline = doc.browseFolder(folderName, folderld, folderType, _
startindex, _
count, countSpecified, _
preview, _

fieldNames.ToArray, files, _
previousindex, nextindex)

Console.WriteLine("headline: {headline)
If Not files Is Nothing Then
Console.WriteLine("Files found: {0}", files.Length())
' files in folder
For Each ff As FolderFile In files
Console.WriteLine("Id:{0}", ff.id)
Next
End If

Explanation

We determine the file list in the "Favorites” folder, identifying these
folders via the FolderType. Because we do not want to output a field
list, we will switch preview to false. Moreover, the entire list should
be requested, where the nullable count parameter is not to be given
a value, so countSpecified will become automatically false. After
starting the browse function we will iterate through the returned
array of FolderFiles objects, and print the file ID to the console.

Comment

Error strings begin often with a technical abbreviation
which may be followed by additional specifications
separated by pipe symbols. The names always begin with
the "DIcErr" character string".

Some personal default folders may now contain other
subfolders which do not consider this function on
specifying folderType. To make their contents also
reachable, the Documents.getFolderStructure function has
been included.
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Documents.cancelWorkflow

Description

Finishes the workflow of a DOCUMENTS file.

Input parameter

fileld: 1 string
ID of the DOCUMENTS file for which a running workflow
should be stopped.

Output parameter

None

Return value

None

Sample VB

Dim fileStatuses() As FileStatus = Nothing

doc.getinbox(fileStatuses)

If fileStatuses.Length > 0 Then
For Each fs As FileStatus In fileStatuses
Console.WriteLine("fileld : {0}", fs.fileld)
doc.cancelWorkflow(fs.fileld)
Next
Else
Console.WriteLine("No files found")
End If

Explanation

All DOCUMENTS files in the logged-in user's Inbox are determined
and, based on the fileld the cancelWorkflow method of a DOCUMENTS
object, are started for each of these DOCUMENTS files.

Comment

Documents.createFile

Description | Create a new DOCUMENTS file.

Input filetype: 1 string

parameter

The name of the file type for which a new DOCUMENTS file should be
created. In order for a new file to be created, the DOCUMENTS file
type must be enabled.

To create a new archive file, you must specify the Destination
identifier for archive.

fields: 0..n FieldData

The number of FieldData objects of the file fields to be written,
whereat their element names equal the field names and their element
values equal the field values. All values must be specified as a string.

addDocs: 0..n DocUploadData

A list including the documents to be added and the related data.

Output None

parameter

Return fileld: 1 string

value A technical identifier of the new file. When an archive file has been
created, the Archive file key will be returned.

Sample VB

' the filetype of the new file
Dim filetype As New String("ftRecord")

‘ Building the fields
Dim fds As New List(Of FieldData)

Dim remark As New FieldData
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remark.name = "hrRemarks"
remark.value = "The remark"
fds.Add(remark)

Dim no As New FieldData
no.name = "hrEmployeeNo"
no.value = "00001"
fds.Add(no)

' Create Attachements

Dim newFile As New DocUploadData
Dim register As New String("Documents")
newFile.register = register

Dim path As New String("test.txt")
newFile.name = path

Dim newByteArray() As Byte = System.lO.File.ReadAllBytes(path)
newFile.data = newByteArray

addDocs.Add(newfFile)
Dim newfFileld As New String(String.Empty)

newFileld = doc.createFile(filetype, fds.ToArray, addDocs.ToArray)

Explanation

A new DOCUMENTS file is created for the "ftRecord" file type. To do this, a
field list is created which accepts the individual FieldData objects whose field
values should then be set for the DOCUMENTS file. In addition, a document is
attached. For this, the "test.txt" file, which must reside in the directory where
the application was started, is read as ByteArray. The created DocUploadData
object is added to the list, which is then included as an array with the
createFile call.

Comment

To create an EAS archive file directly the function Documents.createFile2 is
recommended.

Document

s.createFile?2

Description

Creates a new file similar to Documents.createFile. However this function is
also able to create an EAS archive file directly (without generating a
DOCUMENTS file) via setting the directEAS parameter to true.

Input
parameter

filetype: 1 String
The name of the file type for which a new DOCUMENTS/archive file
should be created. In order for a new file to be created, the file type
must be released.

To create a new archive file, you must specify the Destination
identifier for archive.

directEAS: 1 Boolean
For an EAS archive the file creation can take place directly via setting
this parameter to true. Otherwise a file is at first created within
DOCUMENTS whereat the default values are set and (if applicable) the
scripts are executed.
fields: 0..n FieldData
A list of FieldData objects of the file’s fields to be written, whereat
their element names equal the field names and their element values
equal the field values. All values must be specified as a string.
addDocs: 0..n DocUploadData
A list including the documents to be added and the related data.
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Output None
parameter
Return fileld: 1 String
value A technical identifier of the new file. When an archive file has been
created, the Archive file key will be returned.
Sample VB " the filetype of the new file
Dim filetype As New String("ftRecord@peachitStore1")
‘ Building the fields
Dim fds As New List(Of FieldData)
Dim remark As New FieldData
remark.name = "hrRemarks"
remark.value = "The remark"
fds.Add(remark)
Dim directEAS as Boolean
directEAS = True
Dim newfFileld As New String(String.Empty)
newFileld = doc.createFile2(filetype, fds.ToArray, addDocs.ToArray)
Explanation | An EAS archive file is created for the “ftRecord” file type. To do this, a field list
is created which accepts the individual FieldData objects whose field values
should then be set for the archive file. The archive file is generated directly
(without creating a DOCUMENTS file).
Comment This method is more efficient than Documents.createFile in case of
creating an EAS archive file directly.
Documents.createFile3
Description | Creates a new file similar to Documents.createFile2. However this function is
able to upload a blob from the file system directly. The blobs must be located
in a shared directory specified by the option BlobBasePath in
docsoapproxy.ini, which can be accessed by the SOAPProxy. Instead of the
blob content encoded in base64 format only the relative file path has to be
passed.
Input filetype: 1 String
parameter The name of the file type for which a new DOCUMENTS/archive file
should be created. In order for a new file to be created, the file type
must be released.
To create a new archive file, you must specify the Destination
identifier for archive.
directEAS: 1 Boolean
For an EAS archive the file creation can take place directly via setting
this parameter to true. Otherwise a file is at first created within
DOCUMENTS whereat the default values are set and (if applicable) the
scripts are executed.
fields: 0..n FieldData
A list of FieldData objects of the file’s fields to be written, whereat
their element names equal the field names and their element values
equal the field values. All values must be specified as a string.
addDocs: 0..n DocUploadData3
A list including the documents to be added and the related data.
Output None
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parameter

Return fileld: 1 String

value A technical identifier of the new file. When an archive file has been
created, the Archive file key will be returned.

Sample VB

" the filetype of the new file
Dim filetype As New String("ftRecord@peachitStore1")

‘ Building the fields
Dim fds As New List(Of FieldData)

Dim remark As New FieldData
remark.name = "hrRemarks"

remark.value = "The remark"
fds.Add(remark)

Dim directEAS as Boolean
directEAS = False

" Add a document to the register “Documents”
Dim addDocs As New List(Of DocUploadData3)

Dim sameDoc As New DocUploadData3
sameDoc.register = “Documents”

sameDoc.name = "test.txt"

sameDoc.path = “test.txt” 'located in BlobBasePath
sameDoc.replaceSpecified = False
sameDoc.versioningSpecified = False
sameDoc.deleteBlobSpecified = True
sameDoc.deleteBlob = False

addDocs.Add(sameDoc)

Dim newfFileld As New String(String.Empty)
newFileld = doc.createFile3(filetype, fds.ToArray, addDocs.ToArray)

Explanation | A file is created for the “ftRecord” file type. To do this, a field list is created

which accepts the individual FieldData objects whose field values should then
be set for the file. We will also build a list of DocUploadData3 objects with a
document located in a shared directory specified by the option BlobBasePath.
These lists will then be passed as arrays to the editFile3 method.

Comment

This method is available since WSDL DOCUMENTS-4.0.1870.

Documents.DeleteDocuments

Description

Delete documents from a DOCUMENTS file.

Input parameter

fileld: 1 string
Technical name of file.

doclds: 0..n string
The IDs of the documents to be deleted. These can be
determined via Documents.getFilelnfo.

Qutput parameter

None

Return value

status: 0..n DeleteStatus
An indeterminate number of DeleteStatusobjects that
provide information about a successful/unsuccessful
delete operation.
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Sample VB

Dim fileStatuses() As FileStatus = Nothing

Dim idFolder As New String(String.Empty)

‘ Get all files from the inbox

idFolder = doc.getinbox(fileStatuses)

If fileStatuses.Length <= 0 Then
Console.WriteLine("No file in inbox")
Return True

End If

‘ and check each file for documents

For Each fs As FileStatus In fileStatuses
Dim fileld As New String(fs.fileld)

Dim allFields As Boolean = False
Dim allAttributes As Boolean = False
Dim wishedFieldNames As New List(Of String)

Dim docinfo() As DocInfo = Nothing

Dim fileTypeld As New String(String.Empty)
Dim fileTypeName As New String(String.Empty)
Dim fileTypeLabel As New String(String.Empty)
Dim fds() As FieldData = Nothing

' getFilelnfo for file
fds = doc.getFilelnfo(fileld, allFields, allAttributes,
wishedFieldNames.ToArray, docinfo, fileTypeld, fileTypeName,
fileTypeLabel)
If Not docinfo Is Nothing Then ' there could be documents
Dim delDocs As New List(Of String)
" get all ids of the attached documents
For Each di As DoclInfo In docinfo
delDocs.Add(di.id)
Next
If delDocs.Count > 0 Then
Dim statuses() As DeleteStatus = Nothing
" delete the documents
statuses = doc.deleteDocuments(fileld, delDocs.ToArray)
If Not statuses Is Nothing Then
For Each st As DeleteStatus In statuses
Console.WriteLine("Deleted Document Id: {0} Deleted:
{1} Message: {2}", _
st.id, st.deleted, st.messages)
Next
End If
Else
Console.WriteLine("No documents found")
End If
End If
Next
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Explanation

We determine all DOCUMENTS files residing in the logged-in user's
Inbox. For each of these DOCUMENTS files we call the getFileInfo
method using the fileld to check on the Doclnfo array whether the
DOCUMENTS file contains documents. We will then collect the IDs
of these documents in a deletion list, and then perform deletion via
deleteDocuments. Following this, a check will be made using the
DeleteStatus objects on whether deletion was successful by
outputting the status to the console.

Comment

Documents.deleteFiles

Description

Allows deleting DOCUMENTS files.

Input parameter

filelds: 0..n string
The technical names of the DOCUMENTS files to be deleted.
You can also use the Archive file keys.

Qutput parameter

None

Return value

statusList: 0..n DeleteStatus
An indeterminate number of DeleteStatusobjects that
provide information about successful/unsuccessful delete
operation.

Sample VB

Dim fileStatuses() As FileStatus = Nothing

Dim idFolder As New String(String.Empty)
' Get all files from the inbox
idFolder = doc.getinbox(fileStatuses)

" Now iterate through that array and the files
If fileStatuses.Length > 0 Then
For Each fs As FileStatus In fileStatuses
Console.WriteLine("fileld : {0}", fs.fileld)
Dim filelds() As String = {fs.fileld}
" delete the file
Dim deleteStatus() As DeleteStatus = Nothing
deleteStatus = doc.deleteFiles(filelds)

For Each ds As DeleteStatus In deleteStatus
Console.WriteLine("ld : {0} deleted: {1} messages: {2}", ds.id,
ds.deleted, ds.messages)
Next
Next
Else
Console.WriteLine("No files found")
End If

Explanation

We get the logged-in user's DOCUMENTS files residing in his or her
Inbox. We will then iterate through these DOCUMENTS files and,
after determining the file ID and inserting it into the delete array,
call the DeleteFiles method. The delete status for this operation will
then be printed via the console.

Comment

Documents.describeFileType

Description

Displays detailed information on a file type. This may be archive, field,
tab, or workflow information.
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Input parameter

name: String
The name of the file type for which the information should
be determined. Alternatively, you can also use the id. In this
case, you need to pass an empty string for name.
id: String
ID of file type to be examined. Alternatively, you can use the
name. In this case, you need to pass an empty string for the
id.
categories: 1 string
The string is used to specify the data to be requested. In its
dependency, the corresponding data structures are
populated with FileTypeDescription. The following options
are available:
o "fields"
o "enum“
If the field is of the "enum" type and its
enumeration values are also to be output, then
"enum"” must be specified, together with
"fields", in the categories string: "fields, enum".
The individual values for the languages are
displayed in a single string (1), e.g. "year;
de:Jahr; en:Year".
o “fieldlabel“ / “fieldlable.locale”
Including “fields,fieldlabel” /
“fields,fieldlabel.locale” to the categories string
to get the entire labels of the fields and their
ergonomic names in the current user’s
language, respectively. The returned values are
available for both in the member ‘fieldlabel’ of
FieldDescription, e.g. the value "de:Betreff;
en:Subject” for “fieldlabel” and “Subject” for
“fieldlabel.locale” in case that English is the
current user’s language, respectively.
It has to be mentioned, if the categories string
contains both (“fieldlabel” and
“fieldlabel.locale”), “fieldlabel” will be ignored.
o ‘initialValue
If specification for field values should be
additionally displayed, the categories string
must contain the value "initialValue" in addition
to "fields".
e "docregisters"”
Inserts information on the document tabs in the
FileTypeDescription.
e "archiveinfo"
Inserts archive information into the
FileTypeDescription.
« "workflowinfo*
Inserts workflow information into the
FileTypeDescription.
The individual options can also be assembled comma-
separated into a single string, e.g. "fields, enum,
docregisters, archiveinfo".

Output parameter

None

Return value

description: 1 FileTypeDescription
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Sample VB

Try
Dim ftsd() As FileTypeShortDescr
ftsd = doc.getFileTypes(False)
"and iterate
For Each fsd As FileTypeShortDescr In ftsd
If Not fsd Is Nothing Then

'describe this filetype by passing his "name"
Dim name As String
name = (fsd.name)

" here we want to learn something about the fields in this
filetype, their name and the fieldtype
Dim cat As New String("fields")
Dim ftd As FileTypeDescription
" the call of the documents method at last
ftd = doc.describeFileType(name, ", cat)
Dim fields() As FieldDescription
fields = ftd.fields
Console.WriteLine("Fields count: {0} *, fields.Length())
For Each f As FieldDescription In fields
Console.WriteLine("Fields Name: {0} Type: {1} ", f.name,
f.type)
Next
End If 'if not fsd
Next ' for each
Catch ex AS Exception
Console.WriteLine("DescribeFileType Message: {0}", ex.Message)
Return False
End Try

Explanation

Information on the fields of the file types should be output,
particularly name and field type. This request is controlled via the
category string cat= "fields", which ensures that the fields array is
populated in the returned FileTypeDescription. Next, we need
information saying for which file type this should be performed. For
this, the name of the file type is passed to the describeFileType
method. In the file type description, we then iterate through the fields
and print name and type to the console.

Comment

File type description is essentially controlled through the
"categories"” string. If this is not really given a value, the
resultant data structures will then not be populated with
values either.

The archiveinfo output is only supported for EAS since WSDL
Documents-4.0.1827. If the label of the file type should be
retrieved, you can use the function
Documents.describeFileType2 below.
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Documents.describeFileType2

Description

Displays detailed information on a file type similar to
Documents.describeFileType, however this function can also
determine the file type label in the current user’s language.

Input parameter

name: String
The name of the file type for which the information should
be determined. Alternatively, you can also use the id. In this
case, you need to pass an empty string for name.
id: String
ID of file type to be examined. Alternatively, you can use the
name. In this case, you need to pass an empty string for the
id.
categories: 1 string
The string is used to specify the data to be requested. In its
dependency, the corresponding data structures are
populated with FileTypeDescription. The following options
are available:
o "fields"
o "enum“
If the field is of the "enum" type and its
enumeration values are also to be output, then
"enum" must be specified, together with
"fields", in the categories string: "fields, enum"”.
The individual values for the languages are
displayed in a single string (1), e.g. "year;
de:Jahr; en:Year".
o ‘“fieldlabel“ / “fieldlable.locale”
Including “fields,fieldlabel” /
“fields,fieldlabel.locale” to the categories string
to get the entire labels of the fields and their
ergonomic names in the current user’s
language, respectively. The returned values are
available for both in the member ‘fieldlabel’ of
FieldDescription, e.g. the value "de:Betreff;
en:Subject” for “fieldlabel” and “Subject” for
“fieldlabel.locale” in case that English is the
current user’s language, respectively.
It has to be mentioned, if the categories string
contains both (“fieldlabel” and
“fieldlabel.locale”), “fieldlabel” will be ignored.
o initialValue
If specification for field values should be
additionally displayed, the categories string
must contain the value "initialvValue" in addition
to "fields".
e "docregisters"”
Inserts information on the document tabs in the
FileTypeDescription.
e "archiveinfo"
Inserts archive information into the
FileTypeDescription.
« "workflowinfo*
Inserts workflow information into the
FileTypeDescription.
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The individual options can also be assembled comma-
separated into a single string, e.g. "fields, enum,
docregisters, archiveinfo".

Qutput parameter

None

Return value

description: 1 FileTypeDescription2

Sample VB

Try
samplelLogin(doc)
' First we get the filetypes
Dim ftsd() As FileTypeShortDescr
ftsd = doc.getFileTypes(False)
"and iterate through all returned FileTypeShortDescr

For Each fsd As FileTypeShortDescr In ftsd
If Not fsd Is Nothing Then

Console.WriteLine(New String("-", 10))
Console.WriteLine("FileTypeName: {0}", fsd.name)
Dim id As New String(String.Empty)
id = fsd.id
' the name is optional if we pass the id
Dim name As New String(String.Empty)
Dim cat As New String(String.Empty)
Dim ftd As FileTypeDescription2

ftd = doc.describeFileType2(name, id, cat)
If Not ftd Is Nothing Then
Console.WriteLine("Filetype name: {0} label: {1}",
ftd.name, ftd.label)
End If
End If
Next
Catch ex As Exception
Console.WriteLine("DescribeFileType2: {0}", ex.Message)
Return False
End Try

Explanation

The label of a file type should be displayed. This request is controlled
via the empty category string cat="", which ensures that the label is
populated in the returned FileTypeDescription2. Next, we need
information saying for which file type this should be performed. For
this, the id of the file type is passed to the FileTypeDescription2
method. In the FileTypeDescription2, we print the name and the label

to the console.

Comment

File type description is essentially controlled through the
"categories" string. If this is not really given a value, the
resultant data structures will then not be populated with
values either.

The archiveinfo output is only supported for EAS since WSDL
Documents-4.0.1827. The same applies for this method
itself.

Documents.editFile

Description

Edit a DOCUMENTS file.

Input parameter

fileld: 0..1string, optional
The technical identifier of the file must be specified unless
keyfield, keyvalue and filetype are specified instead.

An Archive file key can also be used as a fileld.
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filetype: 0..1string, optional
File type or Destination identifier for archive of the wanted
DOCUMENTS and archive file respectively. This parameter
will be redundant when specifying fileld; however, it must
be used together with keyfield and keyvalue.

keyfield: 0..1string, optional
Name of a field used as a key field to identify the
DOCUMENTS file. This parameter will be redundant when
specifying fileld; however it must be used together with
keyvalue and filetype.

keyvalue: 0..1string, optional
The value of a key field to identify the DOCUMENTS file.
This parameter will be redundant when specifying fileld;
however, it must then be used together with keyfield and
filetype.

fields: 0..n FieldData
The file fields to be overwritten as the number of field data
objects, where their element names equal the field names
and their element value equal the field values. All values
must be specified as a string.

addDocs: 0..n DocUploadData
A list including the documents to be added and the data
required for it.

Output parameter

None

Return value

newld
The fileld of the edited file is returned. This may change
with archive files in case the file has been versioned.

Sample VB
P Dim filetype As New String(String.Empty)

Dim keyField As New String(String.Empty)
Dim keyValue As New String(String.Empty)
'we add no documents
Dim addDocs As New List(Of DocUploadData)
"the fielddata list with the fielddata to change
Dim fds As New List(Of FieldData)
Dim rm As New FieldData
rm.name = "hrRemarks"
rm.value = "The new remark"
fds.Add(subject)
doc.editFile(fileld, filetype, keyField, keyValue, fds.ToArray,
addDocs.ToArray)

Explanation The fileld of a DOCUMENTS file belonging to the "crmNote" file type
is known. We will build a list of FieldData objects that includes the
name ".name" of the "hrRemarks" field and the new value ".value" for
the "The new remark" field. This list will then be passed as an array
to the editFile method.

Comment Make sure that the file is identified either via the "fileld" or

via "filetype + keyfield + keyvalue" in a unique manner.
However, through WSDL DOCUMENTS-4.0.1827 an archive
file can be only identified via the “fileld”, in other words the
parameter “fileld” must be specified.
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The field values will also be overwritten if the new and old
values are equal.

When using an archive file key, consider the different format
for the respective EE.i, EE.x and EAS archives.

Through WSDL DOCUMENTS-4.0.1827 a new file with the
default values will be created automatically, if no file is
found.

However, since WSDL DOCUMENTS-4.0.1870 an error
should be thrown in this case for archive files.

For versioning or replacing documents you can use the
method Documents.editFile2.

Documents.editFile?2

Descrip | Edit a DOCUMENTS/archive file similar to Documents.editFile. However, this
tion method makes it possible that a document in an active file can be versioned or
replaced by a same-named document.
For archive files this method works in the same way as Documents.editFile.
Input fileld: 0..1string, optional
parame The technical identifier of the file must be specified unless keyfield,
ter keyvalue and filetype are specified instead.
An Archive file key can also be used as a fileld.
filetype: 0..1string, optional
File type or Destination identifier for archive of the wanted DOCUMENTS
and archive file respectively. This parameter will be redundant when
specifying fileld; however, it must be used together with keyfield and
keyvalue.
keyfield: 0..1string, optional
Name of a field used as a key field to identify the DOCUMENTS file. This
parameter will be redundant when specifying fileld; however it must be
used together with keyvalue and filetype.
keyvalue: 0..1string, optional
The value of a key field to identify the DOCUMENTS file.
This parameter will be redundant when specifying fileld; however, it must
then be used together with keyfield and filetype.
fields: 0..n FieldData
The file fields to be overwritten as the number of field data objects,
where their element names equal the field names and their element value
equal the field values. All values must be specified as a string.
addDocs: 0..n DocUploadData2
A list including the documents to be added and the data required for it.
OQutput | None
parame
ter
Return newld
value The fileld of the edited file is returned. This may change with archive files
in case the file has been versioned.
f/zmple Dim filetype As New String(String.Empty)
Dim keyField As New String(String.Empty)
Dim keyValue As New String(String.Empty)
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' the fielddata list with the fielddata to change
Dim fds As New List(Of FieldData)

Dim rm As New FieldData

rm.name = "hrRemarks"

rm.value = "The new remark"

fds.Add(rm)

' Add a document with the same name as the document “test.txt”
' already existing in the register “Documents”

Dim addDocs As New List(Of DocUploadData2)

Dim path As New String("test.txt")

Dim newByteArray() As Byte = System.lO.File.ReadAllBytes(path)

Dim sameDoc As New DocUploadData2
sameDoc.register = “Documents”
sameDoc.name = "test.txt"
sameDoc.data = newByteArray
sameDoc.replaceSpecified = True
sameDoc.replace = True
sameDoc.versioningSpecified = True
sameDoc.versioning = True

addDocs.Add(sameDoc)

doc.editFile2(fileld, filetype, keyField, keyValue, fds.ToArray, addDocs.ToArray)

Explan The fileld of a DOCUMENTS file belonging to the "ftRecord" file type is known. We

ation will build a list of FieldData objects that includes a field with the name
"hrRemarks" and the new value "The new remark". We will also build a list of
DocUploadData2 objects that contains a document with the same name as a
document already existing in the file. These lists will then be passed as arrays to
the editFile2 method.

Comme This method makes versioning or replacing of a document in an active

nt file possible.

Make sure that the file is identified either via the "fileld" or via the
combination "filetype + keyfield + keyvalue" in a unique manner.
Examples for specification of the parameter “filetype” for an archive file
(see Destination identifier for archive):

EAS: Filetype7@myStore

EE.i: $#STANDARD)\REGTEST@eeil

EE.x:
Unit=Default/Instance=Default/View=REGTEST*Unit=Default/Instance=
Default/DocumentSchema=REGTEST@eex]1

The field values will also be overwritten if the new and old values are
equal.

When using an archive file key, consider the different format for the
respective EE.i, EE.x and EAS archives.

If no active file is found, a new file with the default values will be created
automatically. However, in this case for archive files an error will be

thrown.

This method is available since WSDL DOCUMENTS-4.0.1870.
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Documents.editFile3

Description

Edit a DOCUMENTS/archive file similar to Documents.editFile2.
However this function is able to upload a blob from the file system
directly. The blobs must be located in a shared directory specified by
the option BlobBasePath in docsoapproxy.ini, which can be
accessed by the SOAPProxy. Instead of the blob content encoded in
base64 format only the relative file path has to be passed.

Input parameter

fileld: 0..1string, optional
The technical identifier of the file must be specified unless
keyfield, keyvalue and filetype is specified instead.
An Archive file key can also be used as a fileld.

filetype: 0..1string, optional
File type or Destination identifier for archive of the wanted
DOCUMENTS and archive file respectively. This parameter
will be redundant when specifying fileld; however, it must
be used together with keyfield and keyvalue.

keyfield: 0..1string, optional
Name of a field used as a key field to identify the
DOCUMENTS file. This parameter will be redundant when
specifying fileld; however it must be used together with
keyvalue and filetype.

keyvalue: 0..1string, optional
The value of a key field to identify the DOCUMENTS file.
This parameter will be redundant when specifying fileld;
however, it must then be used together with keyfield and
filetype.

fields: 0..n FieldData
The file fields to be overwritten as the number of field data
objects, where their element names equal the field names
and their element value equal the field values. All values
must be specified as a string.

addDocs: 0..n DocUploadData3
A list including the documents to be added and the data
required for it.

Output parameter

None

Return value

newld
The fileld of the edited file is returned. This may change
with archive files in case the file has been versioned.

Sample VB

Dim filetype As New String(String.Empty)
Dim keyField As New String(String.Empty)
Dim keyValue As New String(String.Empty)

"the fielddata list with the fielddata to change
Dim fds As New List(Of FieldData)

Dim rm As New FieldData

rm.name = "hrRemarks"

rm.value = "The new remark"

fds.Add(rm)

" Add a document with the same name as the document “test.txt”
" already existing in the register “Documents”

Dim addDocs As New List(Of DocUploadData3)

Dim sameDoc As New DocUploadData3
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sameDoc.register = “Documents”

sameDoc.name = "test.txt"

sameDoc.path = “test_new.txt” 'located in BlobBasePath
sameDoc.replaceSpecified = True

sameDoc.replace = True

sameDoc.versioningSpecified = True
sameDoc.versioning = True
sameDoc.deleteBlobSpecified = True
sameDoc.deleteBlob = False

addDocs.Add(sameDoc)

doc.editFile3(fileld, filetype, keyField, keyValue, fds.ToArray,
addDocs.ToArray)

Explanation

The fileld of a DOCUMENTS file belonging to the "ftRecord" file type is
known. We will build a list of FieldData objects that includes a field
with the name "hrRemarks" and the new value "The new remark". We
will also build a list of DocUploadData3 objects that contains a
document with the same name as a document already existing in the
file. These lists will then be passed as arrays to the editFile3 method.

Comment

See the comment from Documents.editFile2.
This method is available since WSDL DOCUMENTS-4.0.1870.

Documents.followUp

Description

Move a DOCUMENTS file from the user's Inbox to the resubmission
folder.

Input parameter

fileld: 1 string
File ID.

timeAbsolute: 0..1 DateTime.iso8601
Time at which the DOCUMENTS file is to reappear in the
Inbox. If the time is in the past, this function will fail with an
error. Only times with 15, 30, 45 and 00 minutes should be
used.

timeAbsoluteSpecified: 1 Boolean
Only tells the SOAP client that timeAbsolute was given a
value.

isUTC: 1 Boolean
Information on whether the time refers to international
standard time (UTC=Coordinated Universal Time) and must
therefore be converted to the Portal server's local time first.

comment: 1 string
Comment or reason for returning the DOCUMENTS file.

Qutput parameter

None

Return value

None

Sample VB

Dim newTime As New System.DateTime
newTime = System.DateTime.Now
newTime = newTime.AddMinutes(50)

Dim followUpTime As Nullable(Of System.DateTime)
followUpTime = newTime

' the followUpTime is in local time
Dim isUTC As Boolean = False
Dim comment As New String("New FollowUp")
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' move the file in the follow up folder
doc.followUp(fileld, followUpTime, followUpTime.HasValue, isUTC,
comment)

Explanation

We create a DateTime object with the current time, adding 50
minutes. This time will then be used for the resubmission time, where
the time value is in local time, so UTC has been set to false. Because
followUpTime is, according to its type, nullable, the call in VB requires
the followUpTime.HasValue parameter, which tells the interface
whether a value has actually been allocated or not. After allocating a
comment, the followUp method of a DOCUMENTS object will be
started and the data file will be moved to the resubmission folder.

Comment

e Depending on how the classes are generated from the wsdl, the
method's signature may vary.

e If the DOCUMENTS file already has a resubmission time and a
new time should be set, the time interval must be at least 15
minutes.

e Only absolute times are allowed; whereas relative times such as
"+1 hour" are not.

Documents.getAutoText

Description

Determines auto texts (e.g. %createdAt%) for a specific DOCUMENTS
file.

Input parameter

fileld: 1 string
DOCUMENTS file for which auto texts are determined. An
empty string can also be used.

autoTextNames: 0..n string

Qutput parameter

None

Return value

autoTextValues: 0..n string
Stringarray including the determined auto texts.

Sample VB

'we have access to a fileld

Dim autoTextNames As New List(Of String)
Dim autoTextValues As String()

autoTextNames.Add("%fileOwner%")
autoTextNames.Add("%title%")
autoTextNames.Add("%fileType%")

autoTextValues = doc.getAutoText(fileld, autoTextNames.ToArray())

Dim i As Integer = 0

For Each s As String In autoTextValues
Console.WriteLine("{0} - {1}", autoTextNames.Iltem(i), s)
i=i+1

Next

Explanation

Using a fileld, the auto texts are read and output for the file title, file
type and file owner.

Comment

An overview of auto texts can be found in separate documentation: "DOCUMENTS
AutoTexts". Some of the auto texts cannot be used in Soap access; this particularly
applies to section 3 "AutoTexts for Enumeration Fields"
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If AutoTexts are to be determined from global information and system variables,
such as %currentDate%, $currentWeekday$% oder
$runscript:Scriptname$% , an empty string "" can be used as fileld because
the determined values do not depend on the values of an actual DOCUMENTS file.

Documents.getDocument

Description

Get data and document information on a document.

Input parameter

fileld: 1 string
The unique technical name of the file. You can also use an
Archive file key. The Docid documents can be determined
via Documents.getFilelnfo.

docld: String
The unique technical name of the document.

Output parameter

docld: 1 string
Insofar as no error has occurred, the parameter with the
same name will be returned by the call.
size: 1 Integer
File size in bytes.
mime: 1 string
Mime type of file, if known.
data: 1 Base64 In VB Array of Byte
Document content.

Return value

name: 1 string
File name including extension.

Sample VB

Dim theFileName As New String(String.Empty)

Dim size As New Integer
Dim mime As New String(String.Empty)
Dim data() As Byte = Nothing

' get the document
theFileName = doc.getDocument(fileld, docid, size, mime, data)
Console.WriteLine("Name: {size: {mime: {2}", theName, size, mime)

Dim path As New String(theFileName)
fs = System.lO.File.Create(path)
fs.Write(data, 0, data.Length)
fs.Close()

Explanation

It is assumed that the fileld of the DOCUMENTS file and the docld of
the document to be extracted are known. The byte array will be
filled with the document data on calling the getDocument method.
File.Create is used to create a new data file on the file system and to
write the bytes from the data array to the data file.

Comment

Documents.getFileId

Description

Determines the file id of a temporary search hit for an archive file.

Input parameter

Key 1 String
The Key of an archive file

Output parameter

None

Return value

fileld: 1 String
The file id of the correspondent temporary search hit.
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Sample VB

Try
Dim archives As New List(Of String)
archives.Add("ftRecord@peachitStore1")

' additonal filetypes to be searched
Dim filetypes As New List(Of String)
filetypes.Add("ftRecord")

Dim columns As New List(Of String)
columns.Add("Hit_ArchiveKey")

' the filter for a fulltext search

Dim filter As New String(String.Empty)

"all files

filter = "Search_Fulltext~'fa™

Dim sort As New String(String.Empty)

' Search archive

Dim hitl As New HitList

hitl = doc.report3(filetypes.ToArray, archives.ToArray,
columns.ToArray, filter, sort, "Standard")

Dim rows As Integer = hitl.rows
Dim cols As Integer = hitl.columns
If Not hitl Is Nothing Then
Dim hds() As HitData = hitl.hit
For i As Integer = 0 To rows - 1
Dim hd As HitData = hds(i)
For j As Integer = 0 To cols - 1
If Not String.IsNullOrEmpty(hd.column(j)) Then
Console.WriteLine(New String("-", 10))
Console.WriteLine("Archived file {0} ", hd.column(j))
Dim fileld As String
fileld = doc.getFileld(hd.column(j))
Console.WriteLine("File id {0} ", fileld)
End If
Next
Next i
End If
Catch ex As Exception
Console.WriteLine("Message: {0}", ex.Message)
End Try

Explanation An EAS archive search will be performed and the archive file key of a
search hit will be determined. For this, the file id of the temporary
search hit in DOCUMENTS will be determined and printed on the
console.

Comment This method is available since WSDL DOCUMENTS-4.0.1827.

Documents.getFileInfo

Description Determine file data to field values, attached documents and related
file types.
Input parameter fileld: 1 string

The unique label of the file to be analyzed.
An Archive file key can also be used.
allFields: 1 Boolean
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Indicates whether all fields should be fetched.
allAttributes: 1 Boolean

If true, extended fields such as "DIcFile_Owner" will also be

fetched. See Appendix 5.2 for more information.
wishedFieldNames: 0..n string

The names of the fields to be output. The list will be

ignored if allFields has the value "true".

OQutput parameter

filetypeld: 1 string

ID of file type to which the DOCUMENTS file belongs.
fileTypName: 1 string

Name of file type for this DOCUMENTS file.
fileTypelLabel: 1 string

GUI-label of file type on the Web interface.
documents:0..n Doclnfo

The documents of the DOCUMENTS file including size,

name and ID.

Return value

fieldvalues: 0..n FieldData
Contains the name/value pairs for the individual file fields.

Sample VB

Dim fileStatuses() As FileStatus = Nothing
doc.getinbox(fileStatuses)

If fileStatuses.Length <= 0 Then
Console.WriteLine("No files found")
Return True

End If

Dim fileld As New String(fileStatuses(0).fileld)

Dim allFields As Boolean = True
Dim allAttributes As Boolean = True
Dim wishedFieldNames As New List(Of String)

Dim fileTypeld As New String(String.Empty)
Dim fileTypeName As New String(String.Empty)
Dim fileTypeLabel As New String(String.Empty)

Dim fds() As FieldData = Nothing
Dim docinfo() As DocInfo = Nothing

' getFilelnfo

fds = doc.getFileInfo(fileld, allFields, allAttributes,
wishedFieldNames.ToArray, docinfo, fileTypeld, fileTypeName,
fileTypeLabel)

Console.WriteLine("FileTypeld: {0} FileTypeName: {1} FileTypeLabel",
fileTypeld, fileTypeName, fileTypeLabel)
If Not fds Is Nothing Then
For Each fd As FieldData In fds ' print fielddata
Console.WriteLine("Field: {0} Value: {1}", fd.name, fd.value)
Next
End If ' fds
If Not docinfo Is Nothing Then ' print docinfo
For Each di As DoclInfo In docinfo
Console.WriteLine("DocName: {0} DocSize: {1} Docld: {2}",
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di.name, di.size, di.id)

Next
Else

Console.WriteLine("No docinfo")
End If 'docinfo

Explanation We get a DOCUMENTS file from the logged-in user's Inbox. For this
file we get the information on all available fields, the extended
fields, the file types, and the attached documents. The respective
values are written via the console.

Comment If no field values or documents are output, the output

parameters fieldvalues or documents will become complete
obsolete.

Documents.getFilesInfo

Description Determine file data for field values, attached documents and related
file type.
Input parameter fileld: 1 string

The unique label of the file to be analyzed.
allFields: 1 Boolean
Indicates whether all fields should be fetched.
allAttributes: 1 Boolean
If true, extended fields such as "DIcFile_Owner" will also be
fetched. See Appendix 5.2 for more information.
wishedFieldNames: 0..n string
The names of the fields to be output. The list will be
ignored if allFields has the value "true".
failOnAllErrors 1 Boolean
If true, an exception will be thrown when an error occurs,
and processing will terminate.

Qutput parameter

None

Return value

fileinfos: 0..n Filelnfo
Determines the FileInfo objects belonging to the
DOCUMENTS files which encapsulate the detailed
information on the DOCUMENTS files.

Sample VB

Dim fileStatuses() As FileStatus = Nothing
Dim fids As New List(Of String)
idFolder = doc.getinbox(fileStatuses)

" Now iterate through that array and collect the filelds

For Each fs As FileStatus In fileStatuses
fids.add(fs.fileld)

Next

Dim allFields As Boolean = True

Dim allAttributes As Boolean = True

Dim wishedFieldNames As New List(Of String)
Dim documents() As DocInfo = Nothing

Dim fileTypeName As New String(String.Empty)
Dim failOnAllErrors As Boolean = False

Dim fis() As FileInfo = Nothing

' getFilesinfo

fis = doc.getFilesInfo(fids.ToArray, allFields, allAttributes,
wishedFieldNames.ToArray, failOnAllErrors)

For Each fi As FileInfo In fis
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Console.WriteLine("FileTypeName: {0}, fi.filetypeName)

For Each fd As FieldData In fi.fieldvalues
Console.WriteLine("Field: {0} Value: {1}", fd.name, fd.value)
Next
For Each docinfo As DoclInfo In fi.documents
Console.WriteLine("DocName: {0} DocSize: {1}, docinfo.name,
docinfo.size, docinfo.id)

Next

Next

Explanation We get the DOCUMENTS files from the logged-in user's Inbox, and
collect their IDs. We get the information for all fields as well as the
attached documents on these DOCUMENTS files. In doing so, the
values for the other DOCUMENTS files should also be determined in
case of errors that may occur, e.g. "File not found". The respective
values are written via the console.

Comment See also Documents.getFilelnfo.

Documents.getFileTypes

Description

Determines the file types for the logged-in user.

Input parameter

ignoreRights: 1 Boolean
Specifies whether the names of those file types for which the
user account used has no read permissions are also to be
output.

Qutput parameter

None

Return value

0..n FileTypeShortDescr
An indeterminate number of FileTypeShortDescr objects that
contain the name and ID of the file type.

Sample VB Dim doc as New DOCUMENTS
Try
Dim ftsd() As FileTypeShortDescr
ftsd = doc.getFileTypes(ignoreRights)
For Each sd As FileTypeShortDescr In ftsd
Console.WriteLine("FileType Name: {id: {1}", sd.name, sd.id)
Next
Catch ex AS Exception
Console.WriteLine("Logout Message: {0}", ex.Message)
End Try
Explanation The FileTypes are determined for a DOCUMENTS object disregarding
specific user rights, and storing them in an array of
FileTypeShortDescr objects, followed by an iteration through the array
and outputting ID and name of the determined FileType to the
console.
Comment

Documents.getFilingPlans

Description Determines the filing plans for the logged-in user.
Input parameter None

Output parameter None

Return value 0.. n FilingPlan

A list of filing plans objects.

Sample VB

Dim doc as New DOCUMENTS
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Try
Dim filingPlans() As FilingPlan = Nothing
filingPlans = doc.getFilingPlans()
For Each fpa As FilingPlan In filingPlans
Console.WriteLine("fp: {0} {1}", fpa.name, fpa.label)
Next
Return True
Catch ex As Exception
Console.WriteLine("getFilingPlans: {0}", ex.Message)
Return False

End Try
Explanation The filing plans of a given DOCUMENTS object are determined and
the name as well as the label will be printed on the console.
Comment This method is available since WSDL DOCUMENTS-4.0.1827.

Documents.get

FilingPlanXML

Description

Determines an XML-report of a concrete filing plan.

Input parameter

name 1 String
Technical name of the filing plan, for which an XMI-report
should be returned.

Qutput parameter

None

Return value

1 StringFilingPlan
The XML-report in UTF-8 encoding for the particular filing
plan according to the schema from section 5.7.

Sample VB Dim doc as New DOCUMENTS
Try
Dim filingPlans() As FilingPlan = Nothing
filingPlans = doc.getFilingPlans()
For Each fpa As FilingPlan In filingPlans
Dim xml As New String(String.Empty)
xml = doc.getFilingPlanXML(fpa.name)
Console.WriteLine("FilingPlan: {0} ", fpa.name)
Console.WriteLine(xml)
Next
Catch ex As Exception
Console.WriteLine("Message: {0}", ex.Message)
End Try
Explanation The technical names of all filing plans are determined und then each
of the respective XML-representations is printed on the console.
Comment This method is available since WSDL DOCUMENTS-4.0.1827.

Documents.getFolderStructure

Description

List folder structure within a default folder.

Input parameter

folderType : 1 string
The type label of a personal default folder for which to
determine the structure. A list of available folder types can
be found in the Appendix Label for personal default folders.

Qutput parameter

None

Return value

baseFolder: 1 FolderDescription

Sample VB

Dim fd As FolderDescription
fd = doc.getFolderStructure("Favourites")
If fd.hasSubFolders Then
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For Each fod As FolderDescription In fd.subFolders
Console.WriteLine("Subfolder: {0}", fod.label)

Next
Else
Console.WriteLine("No subfolders")
End If
Explanation A description of the folder structure is requested for the "Favorites"
folder of a given DOCUMENTS object. If the folder has other
subfolders (hasSubFolders), their labels will be written from the
console.
Comment This function does not guarantee that the output order of

folders is exactly as displayed on the Web interface.

Documents.getInbox

Description

Determines the DOCUMENTS files and status information of these
files residing in the logged-in user's Inbox.

Input parameter

None

Output parameter

fileStatuses: 0..n FileStatus
An indeterminate number of FileStatusobjects, including
information on Fileld, workflow step and routing status.

Return value

idFolder: 1 string
Inbox ID.

Sample VB

Try
Dim fileStatuses() As FileStatus = Nothing

Dim idFolder As New String(String.Empty)

idFolder = doc.getinbox(fileStatuses)
' How many files?
Console.WriteLine("Inbox countFiles: {0}", fileStatuses.Length())
Return True

Catch ex AS Exception
Console.WriteLine("getinbox Message: {0}", ex.Message)
Return False

End Try

Explanation

The Inbox of an already logged-in user will be fetched from a
DOCUMENTS object, and the number of DOCUMENTS files will be
printed on the console.

Comment

Documents.getMonitor

Description Determines the routing history (workflow steps) for a DOCUMENTS
file.
Input parameter fileld:
ID of the DOCUMENTS file, the monitor entries of which
should be fetched.
Output parameter None

Return value

monitorEntries: 0..n MonitorEntry
An indeterminate number of monitor entries that reflect the
respective step in the routing history.

Sample VB

Dim monitorentries() As MonitorEntry = Nothing
monitorentries = doc.getMonitor(theFileld)

SOAP Interface Documentation 51




'iterates through all MonitorEntries
For Each moe As MonitorEntry In monitorentries
'Print out the information of each entry
Console.WriteLine()
Console.WriteLine("Status: {0} fileOK: {1}", moe.status, moe.fileOk)
Console.WriteLine("Executive: {0}", moe.executive)
Console.WriteLine("EntryDate: {0} ResponseDate: {1}",
moe.entryDate, moe.responseDate)
Console.WriteLine("Task: {comment: {1}", moe.task, moe.comment)
Next

Explanation The DOCUMENTS object and file ID must already be declared and
instantiated or known. On the doc object, the get monitor method is
called and iterated through the returned MonitorEntry array, where
the respective properties are written to the console for each entry.

Comment see also Documents.getWorkflowSteps

Documents.getProperty

Description

The method reads the properties stored in the file type of a
DOCUMENTS file.

Input parameter

fileld: 1 string
Technical name of file

propertyNames: 0..n string
Array including the names of the properties to be read for
the DOCUMENTS file. The property names must start with a
leading §.

Output parameter

Return value

propertyValues: 0..n string
String array including the determined values that
corresponds to the names.

Sample VB

Dim idFolder As New String(String.Empty)
idFolder = doc.getinbox(fileStatuses)
" Iterate through all inbox files
If fileStatuses.Length > 0 Then
For Each fs As FileStatus In fileStatuses
Dim propertyNames As New List(Of String)
propertyNames.Add("$Test")

Dim propertyValues() As String
propertyValues = Nothing
propertyValues = doc.getProperty(fs.fileld,
propertyNames.ToArray)

Dim i As Integer = 0
For Each val As String In propertyValues
Console.WriteLine("Name: {0} Value: {1}",
propertyNames.Iltem(i), val)
i=i+1
Next
Next
End If

Explanation

The user's Inbox is determined and on each of these DOCUMENTS
files the value of the "Test" property is determined and displayed in
the command line.

Comment
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Documents.getSentFolder

Description Determines the DOCUMENTS files and status information of these
files residing in the SentFolder of the logged-in user.

Input parameter None

Output parameter fileStatuses: 0..n FileStatus
An indeterminate number of FileStatus objects, including
information on Fileld, workflow step and routing status.

Return value idFolder: 1 string
The Id of the SentFolder.

Sample VB
P Try

Dim fileStatuses() As FileStatus = Nothing
Dim idFolder As New String(String.Empty)

idFolder = doc.getSentFolder(fileStatuses)
For Each fs As FileStatus In fileStatuses
Console.WriteLine("FileStatusFileld: {0} IdWorkflowStep: {status:
{2}", fs.fileld, fs.idWorkflowStep, fs.status)
Next
Return True
Catch ex AS Exception
Console.WriteLine("getSentFolder Message: {0}", ex.Message)
Return False
End Try

Explanation The SentFolder of the current user is fetched on a DOCUMENTS object
and the FileStatus information is displayed for each object residing in
the return array.

Comment

Documents.getTasks

Description Determines the tasks for a DOCUMENTS file.
Input parameter fileld: 1 string

Technical name of file.
Qutput parameter None
Return value tasks: 0..n string

The tasks for this DOCUMENTS file.
Sample VB

Try

Dim fileStatuses() As FileStatus = Nothing

Dim idFolder As New String(String.Empty)

' Get the sentfolder

idFolder = doc.getSentFolder(fileStatuses)

" Now iterate through that array

For Each fs As FileStatus In fileStatuses
Dim tasks() As String = Nothing

' get the tasks for this file
tasks = doc.getTasks(fs.fileld)
If tasks.Length > 0 Then
For Each s As String In tasks
Console.WriteLine("Task: {0}", s)
Next

SOAP Interface Documentation 53



End If
Next
Return True

Catch ex AS Exception
Console.WriteLine("GetTask Message: {0}", ex.Message)
Return False

End Try

Explanation

Initially, we will get the user's SentFolder. The ID of the respective
DOCUMENTS file is determined from the returned FileStatus objects
and, using this ID, the DOCUMENTS file's tasks, which are available
as a string array, are fetched. If the array contains at least one entry,
the entire array will be iterated through and the individual tasks will
be written one after another to the console.

Comment
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Documents.getWorkflowPattern

Description Determines the workflows contained in the system.
Input parameter None
Qutput parameter None

Return value

workflowPattern: 0..n WorkflowPattern
An indeterminate number of WorkflowPattern objects
including information on ID and name of workflow.

Sample VB Try
" here we store the returned WorkflowPattern
Dim wps() As WorkflowPattern
'fetch them
wps = doc.getWorkflowPattern()
'iterate through all workflows
For Each wp As WorkflowPattern In wps
"and print the name
Console.WriteLine("Name: {0}", wp.nameWorkflowPattern)
Next
Return True
Catch ex AS Exception
Console.WriteLine("WorkflowPattern Message: {0}", ex.Message)
Return False
End Try
Explanation The method for determining the workflows is called for an already
logged-in user on a DOCUMENTS object. The name and ID for each
object are written to the console in the returned array of
WorkflowPattern objects.
Comment

Documents.getWorkflowSteps

Description

Determines the workflow steps depending on the specified
DOCUMENTS file.

Input parameter

fileld: 1 string
Technical name (ID) of the DOCUMENTS file.

Output parameter

None

Return value

WorkflowSteps: 0..n WorkflowStep

Sample VB

Dim fileStatuses() As FileStatus = Nothing

doc.getinbox(fileStatuses)
For Each fs As FileStatus In fileStatuses

Dim wfsteps() As WorkflowStep
' get the workflowid and get the Steps
wfsteps = doc.getWorkflowSteps(fs.fileld)

For Each wstep As WorkflowStep In wfsteps
Console.WriteLine("Entry: {0}", wstep.entryDate)
Console.WriteLine("Finish: {0}", wstep.finishDate)

SOAP Interface Documentation 55




Next
Next

Explanation The user's Inbox is read and, based on the file ID, the routing history
is read for each file: in doing so, the arrival and initial time are output
for each workflow step to the console.

Comment see also Documents.getMonitor

Documents.listPossibleActions

Description Determines the currently allowed workflow steps of a DOCUMENTS
file.
Input parameter fileld: 1 string
File ID.
Qutput parameter None

Return value

workflowActions: 0..n WorkflowAction
An indeterminate number of WorkflowAction objects
including information on ID and label of the allowed user

action.
Sample VB doc.getinbox(fileStatuses)
' Now iterate through all inbox files
If fileStatuses.Length > 0 Then
For Each fs As FileStatus In fileStatuses
Console.WriteLine(New String("-", 10))
Console.WriteLine("fileld : {0}", fs.fileld)
Dim workflowActions() As WorkflowAction = Nothing
' get all actions
workflowActions = doc.listPossibleActions(fs.fileld)
For Each wa As WorkflowAction In workflowActions
"and print them
Console.WriteLine("Label: {id: {1}", wa.label, wa.id)
Next
Next
Else
Console.WriteLine("No files found")
End If
Explanation The logged-in user's Inbox is read, and an array including the
allowed action is fetched for each file (workflowActions()). For each of
these actions, the ID and its label are then written to the console.
Comment

Documents.listPublicFolders

Description

Determines the public folders.

Input parameter

typeOption: 1Integer with value 0
This parameter is reserved for future use and must be 0
now.

sortOption: TInteger with value 0
This parameter is reserved for future use in the future and
must be 0 now.

Qutput parameter

None

Return value

folders: 0..n FolderDescription2

Sample VB

Dim fd() As FolderDescription2
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fd = doc.listPublicFolders(typeOption, sortOption)
For Each fd2 As FolderDescription2 In fd
Console.WriteLine("{0} {1}", fd2.label, fd2.name

Next ' fd2
Explanation The code determines the top level in the structure of the public
folders.
Comment Only the folders being released and visible on the web interface for

the logged-in user are returned.

Documents.login

Description

Performs login via the DOCUMENTS proxy.

Input parameter

user: String
User name under which to perform login.

principal: String
Principal for which to log in the user.

passwd: String
Password via which the user authenticates himself against
the proxy.

code: String/ empty string
Reserved for future extensions. An empty string must be
passed in this version.

locale: String
Abbreviation for Portal language "de", "en", etc. in which
GUIl-label, error messages, etc. are output.

Qutput parameter

None

Return value

session: 1 string
The return value contains the SessionlID assigned to the user

in the proxy.
Sample VB Dim doc as New DOCUMENTS
Dim session As New String(String.Empty)
Try
session = doc.login(“schreiber”,”peachit”,"willi”,””,"de)
Catch ex AS Exception
Console.WriteLine("Login Message: {0}", ex.Message)
End Try
Explanation The login method is called on a DOCUMENTS object and the
determined session is saved in a string. In case of a possible
exception the exception text will be written to the console.
Comment Login is required at the start of the application. Logout

needs to be performed only at the end of the application, i.e.
it is not required for each individual function call.

You should perform the logout in a Finally block, so that
logout is ensured also after a catch. Otherwise, the user is
considered logged-in until timeout in the proxy, which
prevents renewed login.

Once login has been performed, logout must also be
performed because the session in the proxy cannot be
immediately unlocked.

Competing logins with the proxy, i.e. two or more logins for
the same user are not supported.

If login cannot be performed because the user/principal is
unknown, an error will be triggered.

If the user is to be logged in on a different account, you
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need to use the Documents.trustedLogin function.

Documents.logout

Description Performs logout for the logged-in user.
Input parameter None
Output parameter None
Return value None
sample VB Dim doc as New DOCUMENTS
Dim session As New String(String.Empty)
Try
doc.logout()
Catch ex AS Exception
Console.WriteLine("Login Message: {0}", ex.Message)
End Try
Explanation The logout method is started on a DOCUMENTS object. In case of a
possible exception the exception text will be written to the console.
Comment If login has been performed, logout must also be performed,
because otherwise the session in the proxy will not be
immediately unlocked. See also Documents.login.

Documents.report

Description

Search for documents of a file type and outputting field values as
HTML table.

Input parameter

filetypes: 0..n string
A list of file type names, can be used instead of filetype.

achives: 0..n string
List of Search resource id for an archive. However this
function does not support any archives, thus this list
should be empty.

filter: 1 string
A search condition, as described in the Appendix under
Syntax description for filter expressions; this may remain
empty for displaying all files of the transferred type insofar
as the user account used has the corresponding
permissions.

sort: 1 string
A sort criterion in Field name+ notation for sorting in
ascending order or Field name- notation for sorting in
descending order, or an empty string. Only sorting by a
single field is currently possible. Moreover, the field by
which to sort should also exist in the columns list.

columns: 0..n string
The names of the fields to be output. Besides index fields
of the file type, file attributes such as the title may also be
queried. See Appendix 5.2 for more information.

Return value

report: String
No self-contained and therefore valid HTML page will be
output; instead, only a <table> element).

Sample VB

' The filetypes to be searched
Dim filetypes As New List(Of String)

filetypes.Add("ftEmployee")
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' The fields whose values should be returned
Dim columns As New List(Of String)
columns.Add("hrLastName")

Dim archives As New List(Of String)

Dim filter As New String(String.Empty)
filter = "hrLastName~'Sc*" "hrLastName~'Sc*"

Dim sort As New String(String.Empty)

' sort in reverse alphabetic order
' the field in the sort string has also to be in the columns-list
sort = "hrLastName-"

Dim report As New String(String.Empty)
report = doc.report(filetypes.ToArray, archives.ToArray,
columns.ToArray, filter, sort)

Explanation The "ftEmployee" file type is searched for all employees whose last
names contain the letter combination "sc". The hits are written to
the table element descending alphabetical order, depending on the
database, and displayed on the console.

Comment When directly parsing the string returned by the server, it

should be noted that some characters of the HTML report
are re-encoded through embedding into XML, e.g. ">" in
"&gt;", etc. An id parameter containing a string with a
unique ID to the found file is added to the output report's
<tr> elements.

To form the filter expressions, see Appendix under Syntax
description for filter expressions.

This function is not available for archive files.

Documents.report?2

Description

Search for DOCUMENTS files of one or more file types by outputting a
hit list.

Input parameter

filetypes: 0..n string
A list of file type names

archives: 0..n string
A list of Search resource id for an archive. EE.x archive is not
supported by this function.

filter: 1 string
A search condition, as described in Appendix 1; this may
remain empty for displaying all files of the transferred type
insofar as the user account used has the corresponding
permissions.

sort: 1 string
A sort criterion in Field name+ notation for sorting in
ascending order or Field name- notation for sorting in
descending order, or an empty string. Only sorting by a
single field is currently possible. Moreover, the sort field
must also be present with the columns parameter.

columns: 0..n String
The names of the fields to be output. Besides index fields of
the file type, file attributes such as the title may also be
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queried. The latter is implemented via reserved labels as
listed in Appendix 5.2. When adding "Hit_id" as a column,
that column will list the file ID or, for archive files, the
archive file key (see 5.1). When adding "Hit_ArchiveKey" as a
column, that column will only list the key of each archive
file.

Qutput parameter

None

Return value

hitlist: 1 HitList
A hit list including the result rows and columns.

Sample VB

Dim filetypes As New List(Of String)
filetypes.Add("ftRecord")

' The fields whose values should be returned
Dim columns As New List(Of String)
columns.Add("DIcFile_Id")
columns.Add("DIcFile_Created")

Dim archives As New List(Of String)

' We are searching for files which are created today or yesterday
Dim filter As New String(String.Empty)
Dim today As String = DateTime.Now.ToShortDateString

Dim yesterday As String = DateTime.Now.AddDays(-
1).ToShortDateString

filter = "Search_DateFrom>="" + yesterday + " AND
Search_DateUntil<="" + today + "

"and sort them in order of their creation date
Dim sort As New String(String.Empty)

sort = "DIcFile_Created"

'search

Dim hitl As New HitList

hitl = doc.report2(filetypes.ToArray, archives.ToArray,
columns.ToArray, filter, sort)

Dim rows As Integer = hitl.rows
Dim cols As Integer = hitl.columns

If Not hitl Is Nothing Then
Dim hds() As HitData = hitl.hit
For i As Integer = 0 To rows - 1
Console.WriteLine(New String("-", 10))

Dim hd As HitData = hds(i)
For j As Integer = 0 To cols - 1
Console.WriteLine("Hit {0} Col {1} Value {2}",i + 1,j + 1,
hd.column(j))
Next
Next i
End If ' htil
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Explanation

The "ftRecord" file type is searched for the DOCUMENTS files that
were created yesterday or today. For this, the corresponding
DateTime objects are generated for the filter, and used in the filter.
The hits are to be sorted by the creation timestamp of the
DOCUMENTS file. The resulting hit list is processed by rows and the
values for the two requested columns are written to the console.

Comment

Due to previous technical difficulties with outputting arrays
containing zero elements, the function may yet output an
empty string instead of an array in its report version in case
no files have been found. Applications should therefore
check the report's file type prior to accessing the report.

To form the filter expressions, see Appendix under Syntax
description for filter expressions.

Documents.report3

Description

Search for DOCUMENTS files of one or more file types in one or more
archives considering a specific hit list schema.

Input parameter

filetypes, filter, sort,columns:
See Documents.report2
The columns to be determined must be created in the hit list
schema of the ENTERPRISE archive.
DIcFile_ld, Hit_ArchiveKey and Hit_ld can only be used in the
columns, not with the filter or sort parameters.

archives: : 0..n string
A list of Search resource id for an archive.

hitlistname : 1..1 string
For EASY archives, the name of the hit list schema created in the
archives. For EAS archives, you may not enter any value here.

Qutput parameter

None

Return value

hitlist: 1 HitList
A hit list including the result rows and columns.
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S le VB
ample Dim filetypes As New List(Of String)

' The fields whose values should be returned
" All of them has to be defined in the hitlistname

Dim columns As New List(Of String)
columns.Add("DIcFile_Id")
columns.Add("DIcFile_Created")

Dim archives As New List(Of String)
archives.Add("ftRecord@peachitStore1")

Dim hitlistname as String
hitlistname = ""

Dim filter As New String(String.Empty)
Dim today As String = DateTime.Now.ToShortDateString

Dim yesterday As String = DateTime.Now.AddDays(-
1).ToShortDateString

filter = "Search_DateFrom>=""+ yesterday + " AND
Search_DateUntil<=" + today + "

"and sort them in order of their creation date
Dim sort As New String(String.Empty)
sort = "DIcFile_Created"

'search

Dim hitl As New HitList

hitl = doc.report3(filetypes.ToArray, archives.ToArray,
columns.ToArray, filter, sort)

Dim rows As Integer = hitl.rows
Dim cols As Integer = hitl.columns

If Not hitl Is Nothing Then
Dim hds() As HitData = hitl.hit
For i As Integer = 0 To rows - 1
Console.WriteLine(New String("-", 10))

Dim hd As HitData = hds(i)
For j As Integer = 0 To cols - 1
Console.WriteLine("Hit {0} Col {1} Value {2}",i + 1,j + 1,
hd.column(j))
Next
Next i
End If ' htil

Explanation In the "ftRecord@peachitStore1" archive, the "ftRecord" file type is
searched for DOCUMENTS files that were created yesterday or today.
For this, the corresponding DateTime objects are generated for the
filter, and used in the filter. The hits are to be sorted by the creation
timestamp of the DOCUMENTS file. The resulting hit list is processed
by rows and the values for the two requested columns are written to
the console.
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Comment

See Documents.report2.

Documents.runScript

Description

Run a Portal script.

Input parameter

fileld: 1 string
The technical name of the DOCUMENTS file to be
transferred to the script.

name: String
Name of the script to be called.

paramlList: 0..n string
Input parameter for the script as a list. You need to add a
parameter name, in pairs, and after that the related value,
to the list.

Output parameter

errorMsg: String
Error text for failed call or erroneous execution of the
script.

returnValue: 1 string
The return value of the script.

Return value

returnStatus : Integer
On starting the operation successfully, this value is 0,
otherwise it is an error code.

Sample VB
P Dim fileStatuses() As FileStatus = Nothing
doc.getinbox(fileStatuses)
" Now iterate through all inbox files
If fileStatuses.Length <= 0 Then
Console.WriteLine("No files found")
Return False
End If
Dim fileld As New String(fileStatuses(0).fileld)
Dim name As New String("test")
Dim errorMsg As New String(String.Empty)
Dim returnValue As New String(String.Empty)
Dim paramList As New List(Of String)
paramList.Add("msg")
paramList.Add("This message should be returned")
Dim retStatus As New Integer
retStatus = doc.runScript(fileld, name, paramList.ToArray, errorMsg,
returnValue)
Console.WriteLine("fileld: {0} scriptname: {1}", fileld, name)
Console.WriteLine("errorMsg: {errorMsg)
Console.WriteLine("retStatus: {returnValue: {1}", retVal, returnValue)
Explanation The requirement is that a script named "test" including an input

parameter named "msg" of the String type and the "Message"
default setting have been set. You need to enter "return msag;" as
the script code.

The fileld of the first DOCUMENTS file is determined from the user's
Inbox. Afterwards, the necessary data is assembled for the script
call. In doing so, a string list for the parameters to be transferred is
built which contains the "msg" and "This message should be
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returned" entries. The output parameters and the retStatus are
written to the console after starting the script.

Comment

Available on otrisPortal 5.00 or ELC3.500 or later.

Script parameters must currently always be transferred as
strings.

The return value of the script is also output as a string.

Documents.sendFileAdHoc

Description

Directly sending a DOCUMENTS file

Input parameter

fileld : String
Technical name of file
receivers: 1..n string
The name of the users or groups to which to send the
DOCUMENTS file. You need to specify at least one
recipient.
sendMode : String
The send type. Valid values are: sequential (one after the
other) and parallel_info (concurrently for information).
task: String
Task specification for the recipients of the DOCUMENTS
file.
backWhenFinished: Boolean
Indicates whether the DOCUMENTS file should be returned
to your own user account after the cycle.

Qutput parameter

None

Return value

None

Sample VB

Dim fileStatuses() As FileStatus = Nothing

doc.getinbox(fileStatuses)

If fileStatuses.Length <= 0 Then
Console.WriteLine("No files found")
Return False

End If

Dim fileld As New String(fileStatuses(0).fileld)

Dim sendMode As New String("parallel_info")
Dim task As New String("Info by sendfile")
Dim backWhenFinished As Boolean = False

" we send the file to the group

Dim receivers As New List(Of String)
receivers.Add("Employees")

'send

doc.sendFileAdHoc(fileld, receivers.ToArray, sendMode, task,
backWhenFinished)

Explanation

The first DOCUMENTS file is taken from the logged-in user's Inbox
and sent in parallel for information to the "Employees" group.

Documents.triggerAction

Description

Triggers a user action for a DOCUMENTS file.

Input parameter

fileld: 1 string
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File ID.
actionld: String
The ID of the action to be triggered.
comment: 1 string
The edit note to be entered in the routing history.

Output parameter None
Return value None
Sample VB

Dim fileStatuses() As FileStatus = Nothing
doc.getinbox(fileStatuses)
If fileStatuses.Length <= 0 Then
Console.WriteLine("No files found")
Return False
End If
Dim fileld As New String(fileStatuses(0).fileld)

Dim workflowActions() As WorkflowAction = Nothing
' get all actions
workflowActions = doc.listPossibleActions(fileld)

For Each wa As WorkflowAction In workflowActions
"and print them
Console.WriteLine("Label: {id: {1}", wa.label, wa.id)
doc.triggerAction(fileld, wa.id, "Performed TriggerAction")
Console.WriteLine("Action performed: {0} ", wa.label)
Exit For

Next

Explanation The available user actions are determined for the first DOCUMENTS
file in the user's Inbox. The information on the first action are output
to the console. The doc.TriggerAction triggers this action also for a
DOCUMENTS object.

Comment

Documents.startWorkflow

Description Starts a workflow for a created DOCUMENTS file.
Input parameter fileld: 1 string
File ID.

idWorkflowPattern: 1 string
ID of the workflow to the started.

Output parameter None
Return value None
Sample VB

' Get the Inbox

Dim fileStatuses() As FileStatus = Nothing

doc.getinbox(fileStatuses)

If fileStatuses.Length <= 0 Then
Console.WriteLine("No files found")
Return False

End If

" And grab the id of the first file

Dim fileld As New String(fileStatuses(0).fileld)

Dim wps() As WorkflowPattern
' Get all Workflowpattern
wps = doc.getWorkflowPattern()
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If wps.Length <= 0 Then
Console.WriteLine("No workflow found")
Return False
End If
' And grab the id of the first workflowpattern
Dim workflowld As New String(wps(0).idWorkflowPattern)

" Now start the workflow for this file
doc.startWorkflow(fileld, workflowld)

Explanation In a DOCUMENTS object you determine the logged-in user's Inbox
and read the fileld of the first DOCUMENTS file. Next, the ID of the
first workflow is determined by querying the workflow list, and the
workflow is started for the DOCUMENTS file.

Comment To determine the idWorkflowPattern, see

Documents.getWorkflowPattern.

Documents.testSession

Description Checks whether a session exists for the current SOAP client
Input parameter None
Qutput parameter None

Return value

valid: 1 Boolean
Shows whether a valid session has been set up for the client.

Sample VB While(doc.testSession())
doc.logout()
End While
Explanation A check is made for a DOCUMENTS object on whether a session for
the SOAP proxy has been set up for the client. If this is the case, the
client will be logged off.
Comment

Documents.trustedLogin

Description

Performs login via the Documentsproxy, where the user is logged
under a different account.

Input parameter

user: String
The user name for which login to a different account should
be performed. The "trustedLoginAccount” property including
the value "1" must be present for this user via the
DOCUMENTS client.

principal: String
Principal for which to log in the user.

passwd: String
Password via which the user authenticates himself against the
proxy.

asUser: String
The user to whom to switch.

code: String/ empty string
Reserved for future extensions. An empty string must be
passed in this version.

locale: String
Abbreviation for Portal language "de", "en", etc. in which GUI-
label, error messages, etc. are output.

Qutput parameter

None
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Return value

session: 1 string
The return value contains the SessionID assigned to the user

in the proxy.
Sample VB Dim doc as New DOCUMENTS
Dim session As New String(String.Empty)
Try
‘ ‘schreiber’ login as user ‘oppen’
session =
doc.trustedLogin(“schreiber”,”peachit”,”willi”,”oppen”,””,"de)
Console.WriteLine("TrustedLogin Message: {0}",doc.UserInfo()
Catch ex AS Exception
Console.WriteLine("TrustedLogin Message: {0}",
ex.Message)
End Try
Explanation The trustedLogin method in which user 'schreiber' is logged in as
'oppen’ is started on a DOCUMENTS object. In an exception that may
occur, e.g. if the 'trustedLoginAccount' property does not exist with
the user or is set to a value not equal to '1', the exception text will be
written to the console. The Userinfo method output should output
'‘Bernard Oppen' when successfully switching users.
Comment The same restrictions apply as with Documents.login

Documents.userInfo

Description

Determines the full name of the user for whom the session is
currently set on the proxy.

Input parameter

None

Qutput parameter

None

Return value

name: String
Full name of the user, i.e. first and last name, e.g. "Willi
Schreiber".

Sample VB

Dim doc as New DOCUMENTS
Dim name as New String(String.Empty)
Try
name = doc.userlnfo()
Console.WriteLine("userlnfo Name: {name)
Catch ex AS Exception
Console.WriteLine("userinfo Message: {ex.Message)
End Try

Explanation

The userinfo method is started on a DOCUMENTS object to determine
the name of the currently logged-in user. This is then written to the
console.

Comment

If no user is logged in and therefore no session set up on
the proxy, this will trigger an error.
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3.2 DOCUMENTS classes

ArchiveStatus

Description

Contains information on how successful archiving a DOCUMENTS file
was.

Member

fileld: 1 string
The ID of the DOCUMENTS file to be stored in the archive.
messages: 1 string
An empty string when the DOCUMENTS file has been
archived successfully; else an error string.

Comment

Error strings begin with a technical abbreviation which may
be followed by additional specifications separated by pipe
symbols. The "DIcErrFieldsNotArchived" abbreviation saying
some file fields do not exist in the archive structure and, as
a result, were omitted, is a special abbreviation in this
context. All other "DIcErr..." labels suggest that the
DOCUMENTS file has not been archived.

If a DOCUMENTS file has already been archived, DOCUMENTS
will choose the same target/source archive. Otherwise, an
"active archive" must be assigned to the corresponding file
type via the Portal Manager.

Used in

Documents.archiveFiles

DeleteStatus

Description

Contains staus information on a delete operation.

Member

id: 1 string
The ID of the affected document/DOCUMENTS file.
deleted: 1 Boolean
Indicates whether the document was deleted successfully.
messages: 1 string
If an error occurs with a document, an error string will be
entered here.
Error strings begin with a technical abbreviation which may
be followed by additional specifications separated by pipe
symbols. The names always begin with the "DIcErr" character
string.
In case of errors at file level identical error strings will not be
output for each individual document; instead, an exception
will be triggered.

Used in

Documents.DeleteDocuments
Documents.deleteFiles

DocInfo

Description

Contains the information on the documents attached to a
DOCUMENTS file.

Member

id: 1 string

Document ID.
name: 1 string

Document name.
comment: 1 String

SOAP Interface Documentation 68




Comment on document.
ELC 3.60f/ otris Portal 6.0f or later
size: 1 string
Document size with uniform abbreviation.
Used in FileInfo
DocUploadData
Description Contains information of a document to be uploaded.
Member name: 1 string
Document name (= file name including extension).
register: 1 string
The name of the document tab to which to assign the
document. This parameter may be omitted only when
defining default tabs.
data: 1 base64Binary
The file content as base64 encoded string. In VB a byte array
is enough for accommodating the file content. Conversion is
automatically performed via SOAP.
Used in Documents.createFile
Documents.editFile
Documents.createFile2
DocUploadDataZ?
Description Contains information of a document to be uploaded.
Member name: 1 string
Document name (= file name including extension).
register: 1 string
The name of the document tab to which to assign the
document. This parameter may be omitted only when
defining default tabs.
data: 1 base64Binary
The file content as base64 encoded string. In VB a byte array
is enough for accommodating the file content. Conversion is
automatically performed via SOAP.
replace: 0..1 Boolean
Indicates replacing a document in an active file (if
applicable) by the same-named document to be uploaded.
This parameter is redundant for an archive file.
versioning: 0..1 Boolean
Indicates versioning a document in an active file (if
applicable) by the same-named document to be uploaded in
case of replace being true. This parameter is also redundant
for an archive file.
Used in Documents.editFile2
DocUploadData3
Description Contains information of a document to be uploaded.
Member name: 1 string
Document name (= file name including extension).
register: 1 string
The name of the document tab to which to assign the
document. This parameter may be omitted only when
defining default tabs.
path: 1 string
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The relative path to the BlobBasePath from
docsoapproxy.ini of the file to be uploaded.

replace: 0..1 Boolean
Indicates replacing a document in an active file (if
applicable) by the same-named document to be uploaded.
This parameter is redundant for an archive file and
Documents.createFile3.

versioning: 0..1 Boolean
Indicates versioning a document in an active file (if
applicable) by the same-named document to be uploaded in
case of replace being true. This parameter is also redundant
for an archive file and Documents.createFile3.

deleteBlob: 0..1 Boolean
Indicates whether the file after upload will be deleted.

Used in Documents.createFile3
Documents.editFile3
FieldData
Description Contains name and value for a file field.
Member name: 1 string
Field name
value: 1 string
Field value
Used in Documents.createFile

Documents.editFile
Documents.getFilelnfo
FileInfo
Documents.createFile2
Documents.editFile2
Documents.createFile3
Documents.editFile3

FieldDescription

Description

Contains detailed information on the fields of a FileType.

Member

name: 1 string
The ergonomic field name in the user's locale.
id: 1 string
The technical name of the field.
fieldlabel: 0..1 string
Serves to get the entire label of the field and its ergonomic
name in the current user’s language by including
“fields,fieldlabel” and “fields,fieldlabel.locale” to the
‘categories’-parameter, respectively. In case of no label
specified for the field this fieldlabel is an empty string for
“fields,fieldlabel” and the technical name for
“fields,fieldlabel.locale”, respectively. For further information
see Documents.describeFileType.
type: 1 string
Indicates to which type the field in DOCUMENTS belongs:
e  string: single line text
o text: multiline text
e boolean: true value
e date: date
. enum: enumeration, see below
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. numeric: numeric value
o reference: link field to a different DOCUMENTS file
e other: None of the above.
enum: 0..n string
Contains the versions of the enum field if the field is of the
"enum" type and the "categories" parameter contains "fields,
enum", see Documents.describeFileType. The values for the
individual languages are displayed in a single string (1).
"de:Jahr; en:Year".
Used in FileTypeDescription
Documents.describeFileType
Documents.describeFileType2
FileInfo
Description Contains detailed information on the fields of a FileType.
Member idFile: 1 string
The unique label of the underlying DOCUMENTS file.
filetypeld: 1 string
ID of file type to which the DOCUMENTS file belongs.
filetypeName: 1 string
Name of file type for this DOCUMENTS file.
fileTypelLabel: String
GUI-label of file type on the Web interface.
documents:0..n Doclnfo
The documents of the DOCUMENTS file including size, name
and ID.
fieldvalues: 0..n FieldData
Contains the name/value pairs for the individual file fields.
Used in DOCUMENTS.getFilesInfo
FileStatus
Description Contains status information on a DOCUMENTS file.
Member fileld: String

The DOCUMENTS file ID; for example, it can be used to
determine field contents.
idWorkflowStep: String
The current workflow step the DOCUMENTS file is in.
status: String
The status of the DOCUMENTS file in the system. Allowed
versions:
o DicFile_Status_Default
DIcFile_Status_New
Newly created DOCUMENTS file
o  DlcFile_Status_FollowUp
File transferred from resubmission to Inbox
o  DlcFile_Status_ToForward
User locks DOCUMENTS file and must forward it
o  DlcFile_Status_Info
User has received DOCUMENTS file for
information
o  DlcFile_Status_Task
User locks the file, must forward it, and the
DOCUMENTS file includes a task for the user
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o DIcFile_Status_CancelWorkflow
DOCUMENTS file was canceled by a workflow
o  DIcFile_Status_FileBack
DOCUMENTS file returned from routing process
o DicFile_Status_ArchFile_Default
File is archive file
o DicFile_Status_Consultation
DOCUMENTS file including enquiry from other
user
o  DlcFile_Status_Deleted
DOCUMENTS file deleted

Used in

Documents.getinbox
Documents.getSentFolder

FileTypeArchiveInfo

Description Contains identifying data on the archives to which a filetype refers.
Member nameDest: 1 string
Name of default target archive for the file type. For EAS, the
technical name of the archive server, e.g. "peachitStore1"
idDest: 1 string
Name of the associated, imported archive structure. Empty
string in an EAS archive.
keyDest: 1 string
Corresponding key to FileType, as addressed in the archive.
For EAS archive file type, followed by "@", followed by
technical name of archive server, e.g.
"ftRecord@peachitStorel"
arcSrc: 0,..n SourceArchiv
List of source archives whose DOCUMENTS files can be
reconverted to active processes using this file type.
Used in FileTypeDescription

Documents.describeFileType
Documents.describeFileType2

FileTypeDescription

Description Contains detailed information on a DOCUMENTS file.
Member id: 0..1 string
The ID of the FileType within the system.
name: 0..1 string
The technical name of the FileType.
archiveinfo: 0..1 FileTypeArchivelnfo
Information on the archives to which the file type refers.
docregisters: 0..n RegisterDescription
Information on the document tabs.
fields: 0..n FieldDescription
Description on the individual fields.
workflowinfo: 0..1 FileTypeWorkflowinfo
Information on which workflow is assigned to this file type.
Used in Documents.describeFileType. The "categories" parameter
decides which data structures are populated.

FileTypeDescription?2

Description

Contains detailed information on a DOCUMENTS file. Except for the
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/abel the data structure is the same as FileTypeDescription.

Member

id: 0..1 string
The ID of the FileType within the system.
name: 0..1 string
The technical name of the FileType.
label: : 0..1 String
The ergonomic name of the FileType in the current user’s
language.
archiveinfo: 0..1 FileTypeArchivelnfo
Information on the archives to which the file type refers.
docregisters: 0..n RegisterDescription
Information on the document tabs.
fields: 0..n FieldDescription
Description on the individual fields.
workflowinfo: 0..1 FileTypeWorkflowinfo
Information on which workflow is assigned to this file type.

Used in

Documents.describeFileType2. The "categories" parameter
decides which data structures are populated. This data
structure is available since WSDL DOCUMENTS-4.0.1827.

FileTypeShortDescr

Description Contains status information on a DOCUMENTS file.
Member id: 1 string
The ID of the file type within the system.
name: String
The technical name of the FileType.
Used in Documents.getFileTypes

FileTypeWorkflowInfo

Description Contains information on the default workflow of a file type
Member StdForwarding: 1 RegisterDescription
Contains a description of the default distribution list.
Workflow: 1 Workflowldent
Description of the current workflow assigned to the file type.
Used in FileTypeDescription
Documents.describeFileType
Documents.describeFileType2
FilingPlan
Description Contains the data of a filing plan.
Member name: 1 String
Technical name of the filing plan.
label: 1 String
Filing plan name on the web interface in the current user’s
language.
description: 1 String
Used in Documents.getFilingPlans

FolderDescription

Description

Describes a level within a default folder

Member

id: 1 string
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Technical name of the folder which can be used, for
example, for Documents.BrowseFolder.
label: 1 string
Folder name on the web interface.
hasSubFolders: 1 Boolean
Indicates whether this folder has more subfolders.
subFolders: 0..n FolderDescription
An indeterminate number of folder descriptions of the
subfolders allowing recursive navigation through the folder
tree.

Used in

Documents.getFolderStructure

FolderDescription?2

Description Describes a level within a public folder
Member id: 1 String
Folder id, this can be used, for example, for
Documents.BrowseFolder.
folderType: 1 String
The following folder types are available currently:
. Public
. PublicDynamicFilter - public with dynamic filter
. OnlySubFolder - Contains only subfolders
label: 1 String
Folder name on the web interface.
labelML: 1 String
The entirely multilingual label of the folder.
name: 1 String
Technical name of the folder.
hasSubFolders: 1 Boolean
Indicates whether this folder has more subfolders.
subFolders: 0..n FolderDescription2
A list of folder descriptions of the subfolders allowing
recursive navigation through the folder tree.
Used in Documents.listPublicFolders
FolderFile
Description Describes a file within a default folder.
Member id: 1 string
File ID within the folder.
values: 1 StringlList
The values of the fields for this DOCUMENTS file if
requested.
Used in Documents.getFolderStructure
Documents.bowserFolder
HitData
Description Contains the data for a hit list created during a search.
Member column: 0..n string
The columns in the output report. These may be less than
that specified in the Documents.report2method with
columns in case a requested field in the file type does not
exist or can generally not be read for the user account used.
reserved: 1 Integer
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Reserved for future functionality.
Used in HitList
Documents.report2
HitList
Description Contains the data for a hit list created during a search.
Member rows: 1 Integer
The number of hit list rows; equivalent to number of hits.
columns: 1 Integer
The column number in the output report. This number may
be less than that specified by fie/ds in case a requested
field does not exist in the file type or it is not generally
legible to the user account used.
hit: 0..n HitData.
Contains the actual hit values.
Used in Documents.report2
MonitorEntry
Description Contains the data for the monitor entry of a DOCUMENTS file.
Member status: String
File status, as follows:
e "Angelegt" "Created"
e "Wartend" "Waiting"
e "Gesperrt" "Locked"
e "Weitergeleitet" "Forwarded"
e "Durchgefiihrt" "Processed"
e "Informiert” "Informed"
e "Beendet" "Finished"
e "Zuriickgeholt" "Canceled"
e Initiator wartend" "Waiting Initiator"
e "Beendet und zuriick" "Finished and Back"
e "Versendet" "Sent"
e "Gelesen" "Read"
e "Nicht beriicksichtigt" "Not considered"
e "Escalation 1" "Escalation 1"
e "Escalation 2" "Escalation 2"
e ‘"Escalation” "Escalation”
e "Fehlgeschlagen" "Failed"
e "Angezeigt" "Shown"
executive: 1 string
Login of file editor.
entryDate: 1 string
Date and time of incoming DOCUMENTS file.
responseDate: 1 string
Date and time of file forwarding.
fileOk: 1 Boolean
Whether the DOCUMENTS file has been forwarded in "OK"
status.
task: 1 string
The task assigned to the DOCUMENTS file on incoming files
for editing.
comment: 1 string
The comment given to the forwarder.
Used in Documents.getMonitor
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RegisterDescription

Description Contains information on identifying a document tab.
Member name: 1 string
Contains the name of a document tab.
id: 1 string
Document tab ID.
Used in FileTypeDescription
Documents.describeFileType
Documents.describeFileType2
SourceArchiv
Description Contains information on identifying a source archive.
Member nameSrc: 1string
Name of source archive
idSrc: 1string
Source archive ID
keySrc: 1 string
Source archive key, as specified in the archive
Used in FileTypeDescription
Documents.describeFileType
Documents.describeFileType?2
StringList
Description Contains an indeterminate number of strings.
Member string: 0..n strings
Used in
Documents.bowserFolder
Comment Depending on the programming language and IDE used,
string arrays may be encapsulated once again in a string list.
WorkflowAction
Description Contains ID and label of an action within a workflow.
Member id: 1 string
The action's ID.
label: 1 string
The label of the action in the Web interface.
Used in Documents.listPossibleActions
WorkflowIdent
Description Contains version and ID for the current workflow of a file type.
Member version: 1 string
Version name of workflow.
id: 1 string
Workflow ID.
Used in FileTypeDescription
Documents.describeFileType
Documents.describeFileType?2
WorkflowPattern
Description Contains name and ID of a workflow.
Member idWorkflowPattern: 1 string
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Workflow ID.
nameWorkflowPattern: 1 string
Workflow name.

Used in
Documents.getWorkflowPattern
WorkflowStep
Description
Member comment: 1 string
The comment included in the transition from one workflow
step to the next.
entryDate: 1 string
The date and time of incoming DOCUMENTS file ("Received")
fileOK: 1 string
Indicates whether the DOCUMENTS file has been forwarded
in "OK" state.
finishDate: 1 string
Date and time of outgoing DOCUMENTS files ("Response”)
groupFlag: 1 Boolean
Indicates whether this workflow step has been assigned to a
group.
hasAgent: 1 Boolean
Indicates whether this workflow step has been edited by a
delegate.
idWorkflowStep: 1 string
Workflow step ID
locksFile: 1 Boolean
Indicates whether this workflow step exclusively locks the
DOCUMENTS file for editing.
redirectionDescription: 1 string
Contains brief information on who was the delegate for
which employee on making edits.
status: 1 string
The state of the DOCUMENTS file in the workflow step. See
MonitorEntry/status
task: 1 string
The task that the editor of the workflow step has been
assigned.
user: 1 string
Editor's login. This may also be a script or, in automated
operation, for example, a "decision"”.
wasRedirected: 1 Boolean
Indicates whether this workflow step is based on an enquiry.
Used in Documents.getWorkflowSteps
see also Documents.getMonitor

3.3 Other functions

WSDL

Description

Read WSDL from active proxy through an Http request.

Sample VB

Try
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Dim url AS String
url ="/?wsdl"

Dim webRequest As System.Net.HttpWebRequest
webRequest = Nothing

Dim webResponse As System.Net.HttpWebResponse
webResponse = Nothing

“ doc.Url Proxy location and port
webRequest = CType(System.Net.WebRequest.Create(doc.Url +
url), System.Net.HttpWebRequest)

webResponse = CType(webRequest.GetResponse(),
System.Net.HttpWebResponse)

Dim receiveStream As System.|O.Stream =
webResponse.GetResponseStream()

Dim encode As System.Text.Encoding =
System.Text.Encoding.GetEncoding(0)

Dim readStream As New System.|O.StreamReader(receiveStream,
encode)

Console.WriteLine("Response stream received")

Dim read(256) As [Char]
Dim count As Integer = readStream.Read(read, 0, 256)

Console.WriteLine("WSDL ..." + System.Environment.NewLine)

While count > 0
Dim str As New [String](read, 0, count)
Console.Write(str)
count = readStream.Read(read, 0, 256)
End While

Console.WriteLine("... WSDL")
readStream.Close()
webResponse.Close()

Catch ex AS Exception
Console.WriteLine("sampleGetWSDL Message: {ex.Message)
End Try

Explanation

We will determine the current proxy WSDL via an Http-Get call
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4. HTTPS support (SSL/TLS)

Since DOCUMENTS 4.0d #1870 the SOAP proxy supports also HTTPS connections
as an alternative to HTTP connections from SOAP clients.

The SOAP proxy side HTTPS support is solely restricted to a transport encryption.
A client authentication by the SOAP proxy is NOT supported.

This Documentation supposes knowledge of SSL/TLS functionality and of the using
of digital certificates (X.509). The configurations of the SOAP proxy and code
samples for the applications are described here.

4.1 Configurations in the docsoapprosy.ini

By default the HTTPS support is disabled. When an encrypted connection shall be
used, the following parameters in the INI-file \soapproxy\docsoapproxy.ini
have to be configured:

- SSL=1
enables the SSL support.

- keyfile
Absolute path or relative path to the installation path of a certificate/key file.
The pem-file contains at least the private RSA key and the certificate of the
SOAP proxy. Intermediate certificates from a certificate chain may follow, if
necessary.

The private key has to be included in PEM format (base64 encoded) enclosed
by

The individual certificates are also included in PEM format (base64 encoded)
enclosed respectively by

- keypasswd
Password to read the private key in the key file. The password has to be
specified in plain text.

If a server authentication should be performed at the client side, then the
correspondent trusted CA root certificates are needed.

Depending on the technology used by the client different certificate stores are in
use. A client created via .net or PortalScripting under Windows uses the certificate
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store of the operation system implicitly. Windows opens the appropriate
administration tool for example with the command line call “MMC
certmgr.msc”. In contrast a gSOAP client needs an own root certificate file (see
4.3 for more information). The client application itself must here take charge of
the preparation and regular update of the root certificate file.

If an attacker will succeed in foisting a fake root certificate on the client, or if the
client will trust in a compromised root certificate, the connection would no longer
be secure.

4.2 Creating a self-signed X.509 certificate

For simple test purpose you can create a self-signed X.509 certificate. You only
need OpenSSL installed on the server (e.g. together with EDA -> C:\Program
Files\Documents4\eas\http\bin\openssl.exe). With the following
command a 2048 bit long RSA-key will be generated and saved as testkey.pem.
A self-signed X.509 certificate will also be created and stored in testcert.pem.
The certificate is valid for 365 days.

openssl req -x509 -days 365 -newkey rsa:2048 -out
testcert.pem -keyout testkey.pem

Under Windows it may be necessary to specify the configuration file (e.g.
C:\Program Files\Documents4\eas\http\conf\openssl.cnf) explicitly
with - config <path-to-openssl.cnf>

openssl req -x509 -days 365 —-newkey rsa:2048 -out
testcert.pem -keyout testkey.pem -config <path-to-
oppenssl.cnf>

During the generation some details of the certificate will be requested. You can
skip the not needed fields by entering a point *.":

writing new private key to 'testkey.pem'

Enter PEM pass phrase:

Verifying - Enter PEM pass phrase:

Country Name (2 letter code) [AU]:DE

State or Province Name (full name) [Some-State] :NRW
Locality Name (eg, city) []:Dortmund
Organization Name (eg, company) [Internet Widgits Pty

Ltd] : CompanyName
Organizational Unit Name (eg, section) []:IT
Common Name (e.g. server FQDN or YOUR name) []:localhost

Email Address []:test@domain.de
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The concatenated contents of testkey.pem and testcert.pem build the
content of the new server.pem (keyfile). The specified password above
matches the option keypasswd. For verifying the server on the client side the file
testcert.pem will be used.

4.3 HTTPS/SSL capable gSOAP client with Visual C++ 2008°®

In section 2.7 we have described, how to create a gSOAP client with Visual C++
2008°®. Now we want to transform it into a HTTPS capable client (see Secure
SOAP Clients with HTTPS/SSL from the gSOAP user guide for more information).
For this task we assume that OpenSSL is available on the client. For the project the
following settings should be performed:

- Addinclude path to OpenSSL (e.g. C: \openssl-win32\include) under
Project > Properties > C/C++ > General > Additional
Include Directories.

- Enter the option -DWITH OPENSSL under Project > Properties >
C/C++ > Command Line > Additional Options.

- Add OpenSSL library path (e.g. C: \openssl-win32\1ib) under Project >
Properties > Linker > General > Additional library
Directories.

-  Enterssleay32.liband libeay32.lib under Project > Properties
> Linker > Input > Additional library Dependencies.

Now we adjust the code as follows.

int tmain(int argc, TCHAR* argv([])

{
// Create a gSOAP client object.

DOCUMENTS doc;

// Endpoint URL of soapproxy (change as needed)
doc.endpoint = "https://localhost:11001";

// Init SSL

soap_ssl init();

// Init gSOAP context

if ( socap ssl client context (doc.soap,

SOAP_SSL DEFAULT, //flags for SSL client/server authentication
settings

NULL, //keyfile (cert+key): required only when client must
authenticate to server

NULL, //password to read the key

"testcert.pem", //cafile to store trusted root certificates

NULL, //capath to directory with trusted root certificates

NULL //if randfile!=NULL: use a file with random data to seed
randomness

) )
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soap print fault (doc.soap, stderr);
exit (1) ;

// Sample for login
//

return O;

}
Thereby we have used the self-signed certificate testcert.pem created in 4.2.

Finally we copy the DLLs ssleay32.d11 and 1libeay32.d11 into the directory,
where the application (e.g. docsoapsample.exe) is located. It is essential to
use correct DLLs, which match the linked import libraries. Otherwise the
application will likely crash.

4.4 Further HTTPS/SSL capable clients

As mentioned before, a client created via .net or PortalScripting uses the CA root
certificates from the Windows certificate store implicitly. For test purpose we use
here the certificate testcert.pem from 4.2 and import it using the certificate
snap-in (certmgr .msc) as follows:

- Click the folder (Trusted Root Certification Authorities)thatyou
want to import the certificate into;

- Selectthe menu Action > All Tasks > Import;

- Click Next and then follow the instructions.

WCEF client using Visual C#

The WCF client created according to section 2.8 using Visual C# cannot be
transformed into a HTTPS capable one. It expects “http” as URI-schema. However,
you can create a HTTPS capable WCF client with Visual C# in the same way. The
only thing we need to do in advance is changing the URI-schema “http” of the
location in DOCUMENTS . wsdl to “https”:

<SOAP:address location="https://localhost:11001"/>

Then follow the steps described in the section 2.8.

VB client
The VB client from section 2.6 can easily be turned into a HTTPS capable client by
changing the SOAP proxy URL from HTTP to HTTPS.

Dim doc as New DOCUMENTS

L}

Die URL unter der der Proxy fir diese Anwendung erreichbar
ist.
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doc.Url = "https://localhost:11001"

PortalScripting client
The JavaScript client described in the PortalScripting documentation can be
turned into a HTTPS capable client in the same way as the VB client.

// URL for the SOAP Proxy
var url = "https://localhost:11001/";
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5. Appendix

5.1 Archive file key

5.1.1 EE.i:
The Archive key is the unique identifier of an archive.

Format:

S (#Location) \ArchiveName@technical name of archive server in
DOCUMENTS

Example:

$ (#STANDARD) \EINRECH@enterprisei

4 Portal Client -- User: Administrator {peachit) [localhost:11000]

Application  Server settings  Administration Documents  Help
) Mew é Edit a Update X Delete a Print ﬁ Configure ‘

[ F3 Adrministration
User Management

i Archive type: DEFAULT - INVOICES {peachit_fi20120000004507)

() DEFALLT - INYOICES

Content Generall Advanced settings  Archive description | File act\onsl Propert\esl
Docurments
(=] Public Faldsrs {0 Entriss) File: type I ] = e
(=7 Filetypes (3 Entrias)
L[] Archives (2 Entries) IA'ChlVB D |$[ﬂDEFAULT]\INVDIEES |

Location [DEFALLT
DEFALLT - ORDERS

[ [ Distribution Lists (0 Entries) Create suitable file bpe for archive
S WorkFlows (2 Entries)
----- 2. Filing plans {0 Entries)

Fig. 8: EE.i archive key including details dialog on imported archive structure

The archive file key is a unique identifier of a file within an archive. These keys
contain some components twice. The reason is that DOCUMENTS uses the part

before the ‘|” a a pure file identifier, whereas the back part identifies the archive
structure.

Format:

S (#Location) \ArchiveName,FileId,VersionId|$ (#Location) \Archi
veName@technical name of archive server

Example:

$ (#STANDARD) \EINRECH, 00000009, 001|$ (#STANDARD) \EINRECHReeil
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5.1.2 EE.x:
The View key is the unique and identifier of a view, which is associated to at least
one schema within an archive:

Format:

Unit=UnitName/Instance=InstanceName/View=ViewName®@technical name
of archive server in DOCUMENTS

Example:

Unit=Default/Instance=Default/View=EASY@enterprisex

-

% Portal Client -- User: Administrator {peachit) [localhost:11000]

Application  Server settings  Administration  Documents  Help

[#l Mew = Edit @ Ipdate % Delete =4 Print o8 Corfigure ‘
[+ Community b]

+-- i@ Commerce
=~ Documents I l
; -[=J) Public Folders (37 Entries)

£ () Filetypes (66 Entries) [ #, |nstance=Defaultf EASY W
=-|__| Wiews (76 Entries) |
-] Instance=EASY] EA
| Instance=Default Name |E»’-‘«S'ﬂ
-9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-~ Instance=Default
-9 Instance=Default
- Instance=Default
- 9 Instance=Default
-] Instance=Default
-9 Instance=Default

View (nstance=Defaultl EAST)

Latel |EASY

“wihite-Fool | Unit=D efault/Instance=Default/Pool=DEMO/Pool=E&5SOFT

Instance |Default

valid from |29.D?.2U11 131508

|
|
|
| Key | Lnit=D efault/Instance=D efaul Afisw=EAS 'Y |
|
|
|

Hash | BBECF44E34C7DFYDBO7206033257DDAS

e Instance=Defauk Schemes | Hitist | Search mask |
N
-9 Instance=Default [ ¥&H5a
8 o Marme Default distribution list
-] Instance=Default
-~ Instance=Default EASY
-9 Instance=Default
-9 Instance=Default
| 9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-9 Instance=Default & (3]

-9 Instance=Default
-9 Instance=Default
-9 Instance=Default
-1 Instance=Default

Apply @ @

B O oy B SO B e O B B O e O B e O e O O e e N S Wl (il (o SO g SO B SO B SO e I e e R

2
2]
H
2]
H
2]
H
2
H
H
tl
2
2]
H
] Instance=Default
H
2]
H
2
H
2
tl
2
2]
H
2]
H
2]
H
H

|
{
|
{
|
|
|
|
)
|
{
|
{
|
|9 Instance=Default
|
|
|
|
|
|
{
|
{
|
{
|
)

Fig. 9: EE.x view key including details dialog on imported archive structure
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The Schema key is the identifier of a schema within an archive.
Format:

Unit=UnitName/Instance=InstanceName/DocumentSchema=SchemaNam
e

Example:

Unit=Default/Instance=Default/DocumentSchema=EASY

-

% Portal Client -- User: Administrator (peachit) [localhost:11000]

i Mew = Edi & Update K Delete = Print 8 Configure ‘

_I Archive type: Instance=Default/ EASY (peachit_fi20070000000532)

=17 All Schemas (162 Entries,
(21 Instance=Default/ 4| | General | Advanced settings| Archive deseription | File actions | Properties |
_7) Instance=Default/ A

21 Instance=Default) C File type: |Easy_Live) é g
_7) Instance=Default/ D
[ Instance=Default) D I Archive 1D |Unit=Defaulta’lnstance=Default!DocumentSchema=EASY I

|E|--- Instance=Defaultf E T

[ab’ Text.INDEX (Mun
[3 TITLE (Text) [
[abl DESTINATION (T
[36 YERSION_COM

Create suitable file type for archive ]

Fig. 10: EE.x schema key including details dialog on imported archive structure

The archive file key of an EE.x file is formed as follows:
Format:

Unit=UnitName/Instance=InstanceName/Pool=PoolName
/Document=FileID|Schema-key@technical name of archive server
Example:

Unit=Default/Instance=Default/Pool=DEMO/Pool=EASY/Document=E
ASY.45C76F221D3E11DF92AF080027B22D11 |Unit=Default/Instance=D
efault/DocumentSchema=EASYReexl
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5.1.3 EAS:
An archive key of EAS is composed as follows:

Format:

FileType@technical name of archive server in DOCUMENTS

Example:

ftRecord@peachitStorel

Application  Server settings  Administration Documents  Help

i INew (S Edt & Update K Delete g Print = Configure ‘

I Archive server
&£ Administration A [ 9 [

I - User Management

a4 -7 Documents General | User accnuntsl Lacks and \imitatmns' Archive server accessl Prnpart\es'
(2] Public Folders (5 Entries)
4[] Filetypes (6 Entries) Name | peachitSioiel | [Fliain server
4 127 ft¥acationApplication Label Stare 1
1 ftSickCertificate
b (2] ftOrder Archive software [ DOCUMENTS [EAS) -

b (2 fEmployee Hostname  localhast Pot G085
1] ftRecord

Site [root page]  feas’archives/storel

EE . Urit [Defaul

peachitStorel (DOCUMENTS (EAS))

1> L4l Distribution Lists (1 Entry)

1> - Workflows (4 Entries) Feport server

b -£ Filing plans {1 Entry) [ &ctive

+~{E Number ranges (1 Entry) HuostérchiveRepart ||Uca\hgs[ Port
-#| Qutbar (1 Entry)
Scripting (24 Entries)

4 Processes (21 Entries)

: -1 Scratch Copy (0 Entries)

{120 Scratch Copy (Archive files) (0 Entries)

{7 Deleted Processes (2 Entries) l oK I | Apply ‘ l Cancel ]

4% Log-book (21 Entries)

[]EASY EMTERPRISE authentication

| Impart archive stiucture |

s |
Fig. 11: Archive server EAS

The archive file key of an EAS file performs as follows:
Format:

Archive file GUID|FileType@technical name of archive server
Example:

£502d475-587e-4020-bf15-7017722db169 | ftRecord@peachitStorel

SOAP Interface Documentation 87



5.2 Search resource id for an archive

Archive software | Search resource id
EAS Filetype@Archive server
z.B. Filetypel@storel
EE.i $(#Location)\Archive name@Archive server
z.B. $(#STANDARD)\REGTEST@eei
EE.x View-Key@Archive server
z.B. Unit=Default/Instance=Default/View=REGTEST@eex ]

The search resource ids (see also Archive file key) are used by Documents.report2
and Documents.report3.

5.3 Destination identifier for archive

Archive software | Destination identifier for archive

EAS Filetype@Archive server

z.B. Filetypel@storel

EE.i $(#Location)\Archive name@Archive server
z.B. $(#STANDARD)\REGTEST@eeil

EE.x View-Key*Schema-Key@Archive server
z.B.

Unit=Default/Instance=Default/View=REGTEST*Unit=Default/Instance=Defa
ult/DocumentSchema=REGTEST@eex1

The destination identifiers for archive (see also Archive file key) are used by the
following functions:

e Documents.createFile
e Documents.createFile2
e Documents.createFile3
e Documents.editFile

e Documents.editFile2

e Documents.editFile3

5.4 Field labels for reading file attributes in reports/search

There are two categories of specific labels that can be used as field names to
output file attributes. The labels of the first category are globally applicable.
However, for technical reasons later versions may make changing these names

necessary.
Label Meaning
DIcFile_Title File title
DIcFile_Created Date created
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DIcFile_Owner File owner
DIcFile_LastModified Last modified
DIcFile_LastEditor Last editor

DIcFile_Id Unique technical file name

The second category of specific labels will never change. If, however, a field of the
same name exists for one of these names, then the corresponding field value
instead of the file attribute of the same name will be output for that file type.

Label Meaning

Title File title

CreatedAt Date created

FileOwner File owner

LastModifiedAt Last modified

lastEditor Last editor

id Unique technical file name

5.5 Label for personal default folders

Label Meaning

Favorites Favorites folder

Inbox Inbox folder

Sent Sent

SendingFinished "Finished Sending" folder

InWork "In Progress” folder"

FollowUp Resubmission folder

Deleted "Deleted" folder"

Tasks Tasks folder

LastUsed "Last Used" folder"

InTrouble "InTrouble" folder"

Used in Documents.getFolderStructure
Documents.bowserFolder

5.6 Syntax description for filter expressions

The global notation for individual filter conditions for the Documents.report and
Documents.report2 operations is:

Field name Comparison operator Value

The following comparison operators are allowed: = (equal to), < (less than), >
(greater than ), <= (less than or equal to ), >= (greater than or equal to ), ~
(contains) and <> or != (not equal to).

The comparison operator should neither be preceded nor followed by spaces. If a
value contains spaces, it must be enclosed in quotes.

Except for range searches, the advanced DOCUMENTS search always uses the
~ (contains) operator. Only when using this operator the search term will be split
into individual words. All other operators will process the search term as a whole.

Example:
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The User='Eva Frisch' condition is met only by files, where the User
field contains exactly the text Eva Frisch without any other characters
preceding it or following it.

By contrast, the User~'Eva Frisch' condition will be interpreted either as
'"Eva&Frisch' (logical and) oras 'Eva|Frisch' (logical or). It depends
on the server configuration (see LogicalAndBetweenSearchPhrases in
the ,documents.ini”). With search method 0 the according result is a list of
files containing both character strings at arbitrary positions in the field (and-
setting) or just one of them (or-setting). Here the result is the same as with
inputting both words (without quotes) in the Web form for advanced
DOCUMENTS search.

The filter condition should be as follows when searching for files where Eva Frisch

or Stefan Gross have been entered as the users:

User~'""Eva Frisch"|"Stefan Gross"'

Multiple filter conditions can currently only be linked with AND (logical "and")

operators. OR operators are not yet available at this level.

Advanced file attributes can be used in the filter expressions as follows:

Label Meaning

"Search_Fulltext" Full text search

"Search_DateFrom" From

"Search_DateUntil" To

"DlcFile_Title" File title

"Search_Owner" File owner

"Search_LastEditor" Last editor

"Search_ModDateFrom" From (Last modified)

“Search_ModDateUntil” To (Last modified)

For further details about filter expressions (such as archive related restrictions)

please read also the chapter ,Using filter expressions with FileResultSets” in the

PortalScripting reference manual.

5.7

Schema for getFilingPlanXML output

<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<xsd:element name="FilingPlan" type="FilingPlanEntryList"/>
<xsd:complexType name="FilingPlanEntryList">
<xsd:sequence>

<xsd:element name="FilingPlanEntry"
type="FilingPlanEntryType" />

</xsd:sequence>
<xsd:attribute name="name" type="xsd:string"/>

<xsd:attribute name="label" type="xsd:string"/>
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</xsd:complexType>
<xsd:complexType name="FilingPlanEntryType">
<xsd:sequence>

<xsd:element name="Index" type="xsd:string"/>
<xsd:element name="Label" type="xsd:string"/>
<xsd:element name="Customl" type="xsd:string"/>
<xsd:element name="Custom2" type="xsd:string"/>
<xsd:element name="Custom3" type="xsd:string"/>

<xsd:element name="FilingPlanEntry"
type="FilingPlanEntryType" />

</xsd:sequence>
<xsd:attribute name="id" type="xsd:string"/>
</xsd:complexType>

</xsd:schema>

5.8 Client timeouts

SOAP clients often implement a maximum waiting time for the SOAP proxy’s
response. After that period of time the client aborts the connection. The
occurrence of such a client timeout leads to a session loss. Speaking more
precisely, the logout is no longer possible afterwards, because the client lacks a
valid session Id. The sequence diagram from Fig. 12 illustrates the occurrence of a
client timeout after 60s.

SOAP-Client SOAPProxy Archive
(TO=605) (TO=3600s) DOCUMENTS Server (TO=6005)
| I I |
| 1 | |
_ Request » "1 Invoke e.g. createFile2() ! :
T " archiveFile() '
60s
62s
[success] fileld
[success] fileld I
| Response - I

>|(4 ............................. 1 I |

Occurrence of client timeout
== Session loss!

Fig. 12: Sequence diagram of a client timeout

The session, which has been lost from the client’s point of view, it is still alive
within the proxy and the server. If this occurs frequently, all licenses will be
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allocated after a while (limit: 3 SOAP sessions per user), and further logins will be
rejected. Only when the proxy timeout period has also elapsed (see Fig. 3), a lost
session will be freed again. To avoid this scenario the period of client timeouts
should be amply dimensioned, if they are not dispensable.
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